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Technology Overview

Introduction to Dash
The Dash DSP Controller is a Windows-based, full-featured application that configures and controls the DSP hardware.

Systems can be designed to perfectly match specifications and conform as requirements change or evolve. All classes of

audio processing modules for signal routing and shaping are provided.

Dash provides a revolutionary way of thinking about DSP software. This is a software designed by audio professionals for

audio professionals. It uses an interface layout that will be very intuitive to even the most novice integrator yet

extremely powerful in its capabilities.

Quick Start
1.

© 0 ND U AW N

Install Dash software.

Connect DTX DSP to the same network as the computer running Dash.

Use the PoE connection on a DTX-44D, use the LAN connection on all other DTX devices.

Open Dash.

Click the plus (+) sign in the Device tab row.

Select a template that matches the device you are connecting.

Click the ‘Device List’ in the top right corner of Dash.

Select the desired device from the list of discovered devices and click ‘Set IP’.

Change the IP from the default 169.254.10.227 to a valid, unused static address on the active subnet.

10. Click ‘Connect’.
11. The green ‘LED’ next to the device name on the Device tab should now be green.

12. You are all set!



Hardware
Safety Instructions

Please review the following safety precautions. If this is the first time using this model, then read this manual before installing
or using the product. If the product is not functioning properly, please contact your local dealer or Aurora for further
instructions.

The lightning symbol in the triangle is used to alert you to the presence of dangerous voltage inside the product

A that may be sufficient to constitute a risk of electric shock to anyone opening the case. It is also used to indicate
improper installation or handling of the product that could damage the electrical system in the product or in other
equipment attached to the product.

The exclamation point in the triangle is used to alert you to important operating and maintenance instructions.
Failure to follow these instructions could result in injury to you or damage to the product.

Be careful with electricity:

A ® Power Outlet: To prevent electric shock, be sure the electrical plug used on the product power cord matches
the electrical outlet used to supply power to the Aurora product. Use the power adapter and power connection
cables designed for this unit.

® Power Cord: Be sure the power cord is routed so that it will not be stepped on or pinched by heavy items.
® Lightning: For protection from lightning or when the product is left unattended for a long period, disconnect
it from the power source.

Also follow these precautions:
A e Ventilation: Do not block ventilation slots, if applicable, on the product, or place any heavy object on top of
it. Blocking airflow could cause damage. Arrange components so that air can flow freely. Ensure that there
is adequate ventilation if the product is placed in a stand or cabinet. Put the product in a properly ventilated
area, away from direct sunlight or any source of heat.
Overheating: Avoid stacking the Aurora product on top of a hot component, such as a power amplifier.
Risk of Fire: Do not place unit on top of any easily combustible material, such as carpet or fabric.
Proper Connections: Be sure all cables and equipment are connected to the unit as described in this manual.
Object Entry: To avoid electric shock, never stick anything in the slots on the case, or remove the cover.
Water Exposure: To reduce the risk of fire or electric shock, do not expose to rain or moisture.
Cleaning: Do not use liquid or aerosol cleaners to clean this unit. Always unplug the power to the device
before cleaning.
ESD: Handle this unit with proper ESC care. Failure to do so can result in failure.

FCC
This device complies with Part 15 of the FCC Rules. Operation is subject to the following two (2) conditions:
1. This device may not cause harmful interference.

2. This device must accept any interference received, including interference that may cause undesired operation.

ce A

Trademarks

All trademarks in this document are the properties of their respective owners.



Front Panel Features

@ USB (Audio) — USB 2.0 Type A connector. Used in conjunction with the USB Sound card feature. Requires a USB
Type-A to USB Type-A cable, included in box. The USB connection can also be used as a sound card with a PC or

Mac using a generic HID audio. The driver will appear as a “Crestone USB Soundcard” in your computers sound
settings.

@ Status LED — A green LED indicates network connectivity on the LAN connection.
@ Power LED — A green LED indicates power to the unit is good.

@ I/0O LEDs — A green LED indicates analog connectivity.

Rear Panel Features

@ Dante Ethernet — Primary and secondary Ethernet connections for Dante audio. Secondary connection can be used
for to provide redundancy for the Dante audio network or can be used to daisy chain additional devices. PoE is
not passed on.

DTX-44D — 10/100Mbps, PoE PD (15W) on top connector
All Others — 10/100/1000Mbps, no PoE
NOTE: This port has different MAC and IP addresses than the LAN Control Interface (not applicable on DTX-44D).



@ Analog Inputs — Balanced or unbalanced high impedance inputs support Line or Mic level with +48VDC phantom
power. Channel count varies per Model. Mating connectors provided in box.

Signal Label
+ Pin 2 Tip
-* Pin 3 Ring
Pin 1 Sleeve
*do not use (-) for unbalanced

@ Analog Outputs — Balanced or unbalanced 600Q outputs. Channel count varies per Model. Mating connectors
provided in box.

Signal Label
+ Pin 2 Tip
-* Pin 3 Ring
Pin 1 Sleeve
*do not use (-) for unbalanced

@ Serial Communication — RS-232 and RS-485 connections. A +12VDC connection can be used with along with the
serial connections to power a remote serial device such as a RS-485 control panel. The Ground connection is
shared between the RS-232 and RS-485. Mating connectors provided in box.

NEGEIRELL Signal
+12V Aux Power
A RS-485 A(-)
B RS-485 B(+)
h GND
RX RS-232 Receive
X RS-232 Transmit

@ DC Power Input — 12VDC, 10W, center positive power Input. Provides alternate power source to PoE. Can be used
simultaneously with PoE for redundant power.

(® GPIO - General Purpose I/0. The function of the GPIO pins can be configured in the GPIO Settings section of the
Dash Software. Mating connectors provided in box.

Signal Label
\" +3.3VDC @ 500mA MAX
D GPIO Common
h GND

Below are general definitions of the GPIO depending on how they are defined in Dash:

GPIO Input: The port value is considered ‘High’ if the voltage applied to the ‘D’ pin is greater than 2VDC. The port

value is considered ‘Low’ if the voltage applied to the pin is less than 0.3VDC. Input pins can support up to 12VDC.

GPIO Output: When the port is triggered ‘High’, the ‘D’ pin will output 5VDC with a drive current of 100mA; when
triggered ‘Low’ the pin will equal ground. The maximum total current if all 8 pins are configured as outputs is
500mA.

GPIO ADC Input: When the port is configured as an ADC input, an external potentiometer can be connected as a
volume control.

10



@ LAN Control Interface — 10/100/1000Mbps Ethernet control interface. Use this interface to connect to Dash control
software or to use UDP commands from a third-party source.
NOTE: This port has different MAC and IP addresses than the Dante Audio ports.

@ AC Power Input/Switch — 110-240VAC 50/60Hz, 40W Max power inlet via IEC 320 C14 socket. Main power switch for
unit must be in the ON (I) position for normal operation.

@ Ground Lug — Ground lug to provide chassis ground. Secure to earth ground according to code.

11



o use

Analog Ch 1 N
T >
|
|
|
|
|
|
| I
|
| I
| .
| Analog Ch n >
1
Generator ,
I
Auto !
Mixer _ Matrix
Dante Ch 1 N
T >
|
1
|
Signal I | |
Generator I | .
| | |
| | .
| | o
| | i
I
|
| ;!
| Dante Chn >
-
L
Signal o
Generator Auto Mix Output N
I ! g
I
i
i
usB '
Aut | e
1
Lo
AEC : >
T
]
I
I
b P ANC >

Audio Signal Flow Diagram

12



Software

Software Installation
A Windows PC with a processor of 1 GHz or higher and:

e Windows 7 or higher version.
e 1 GB free storage space.

e 1024 x 768 resolution.

e 24 bit or higher color.

e 2GB or higher memory.

e Network (Ethernet) port.

CATS5 cable or current Ethernet network
Visit web page address https://support.auroramultimedia.com/dash/
Download software
1. Install files.
After the software is installed, use one of the following methods to enable the software:

e Desktop icons
e Start menu

When starting the software for the first time, it may take some time (1-15s) to start. Please be patient.
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Software Operation
After starting the software, the main screen will look like the image below:

File Menu
The File menu is for opening and saving presets to the computer during offline configuration. Presets are stored on the

DTX devices by default. In the case where you are configuring a system offline, that configuration can be saved to a local
file on the controlling computer. This is important because when a live device is connected to the Dash software, the
current active settings of the DTX device will be uploaded to the Dash software, including all stored presets. After the
device is active, a saved preset configuration can be loaded from the host computer and pushed to the device.

Here are the steps to load an offline configuration file when NOT connected to an active device.

e Click ‘File | Open’
o Select the file from the local storage and click ‘OK’

When the active Device tab is connected to a DTX device, the steps to open a saved file are different.

e Click the ‘Load Preset’ button next to the preset list n

e Select the preset from the list into which you wish to load the saved configuration file.

e Select the file from the local storage and click ‘OK’

e The configuration will be uploaded and saved to the device in the selected preset. The preset will NOT be made

active automatically.

14



Settings Menus

Device Setting

NOTE: This menu selection is only active when
a DTX device is connected to Dash.

This dialog window provides the basic
configuration information about the
connected device.

Device Name: Change the name of the device
by directly typing in the field. This device
name will show up in Dash anywhere the
device is addressed. This name is saved to the
hardware.

Device IP Address: The IP address of the LAN

interface. NOTE this is a different IP address than the Dante interface and is static. Since many control systems use
hardcoded IP addresses to send commands to devices, DHCP is not supported for this interface. Be sure to use static
addressing on this network or use DHCP reservations to ensure the address is not duplicated on another device on the

network.

Gateway: The default gateway for the network.
Netmask: The network mask associated with the desired subnet.
Mac Address: The MAC address of the LAN interface. NOTE this is a different MAC address than the Dante interface.

Default Preset: Determines the default preset that should be made active on the device after a power cycle event. It can
be either one of the 16 presets or can be set to load the last active preset before power cycle.

Set As Host: Enables device mirroring. See

15



Appendix A: Device Mirroring for more information.
Backup Device ID: If ‘Set As Host’ is set to ‘On’ this sets the IP address of the backup device on the network.

Center Control Response: When set to on, enables control responses on the DTX device. Set this to ‘ON’ when using an
external controller that expects a response to control messages.

Real Time Save: Saves any device changes to the active preset in real time. Setting this to ‘On’ can ensure that the exact
state of the device is restored in the event of a power cycle if ‘Previous loaded preset’ is selected in the ‘Default Preset’
parameter. If set to ‘Off’ and changes are made to the device that are not saved to a preset, those changes will be lost
after a power cycle event.

Enable Model Selection Box: If set to ‘On’, the model selection box will appear as soon the Dash software is loaded. This
is set to ‘Off’ by default.

UDP Control Port: Sets the UDP control port for remote communication with the device.

UART Settings: Baud Rate, Data Bits, Stop Bit, and Parity Bit can be set for both the RS-232 and RS-485 ports of the
device.

OK: Setting are saved to the device and the dialog box is closed.
Cancel: All changes are lost, and the dialog box is closed.

GPIO Setting

All DTX units above 4x4 channels include 8 GPIO interfaces. The “GPIO Setting” dialog allows for the configuration of this
/0.

Channel Buttons: 8 buttons across the top of the dialog box selects which GPIO channel is being configured.

Direction: Determines whether the selected channel is an input or an output. Inputs and Outputs will have different
value selections for Control Type.

Active: Enables or disables the selected GPIO channel.



Control Type (inputs only): Determines the function which will control or be controlled by the GPIO. Additional

parameters will differ depending on the Control Type selected. The following tables define the additional parameters

based on the value of this field.

Direction = ‘Input’
Control Type Value
Preset: Changes
the preset to a
defined value
when a trigger
event occurs.

Routing: Creates a
matrix route point
when a trigger
event occurs.

Gain: Changes the
gain value on the
predetermined
channel when a
trigger event
occurs.

Mute/Unmute:
Will mute a
predetermined
channel when the
trigger is active and
will release the
mute when it
becomes inactive.

Associated Dialog Box

Additional Parameters
Trigger Type: ‘High level trigger’ will trigger the channel
when the voltage on the pin is above the threshold. ‘Low
level trigger’ will trigger the channel with the voltage on
the pin is below the threshold.

Preset: Selects which preset will be applied upon a trigger
event.

Trigger Type: ‘High level trigger’ will trigger the channel
when the voltage on the pin is above the threshold. ‘Low
level trigger’ will trigger the channel with the voltage on
the pin is below the threshold.

Input & Output: Selects the two points that will be routed
together upon a trigger event.

Trigger Type: ‘High level trigger’ will trigger the channel
when the voltage on the pin is above the threshold. ‘Low
level trigger’ will trigger the channel with the voltage on
the pin is below the threshold.

Channel: Selects which ‘Input’, ‘Output’ or ‘System’
channel will be affected by the gain change.

Step: Defines the size of the gain change in dB of the gain
change.

Trigger Type: ‘High level trigger’ will trigger the channel
when the voltage on the pin is above the threshold. ‘Low
level trigger’ will trigger the channel with the voltage on
the pin is below the threshold.

Channel: Selects which ‘Input’, ‘Output’ or ‘System’
channel will be affected by the mute/unmute.
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Command: Sends a
hex command
string via RS-232
when a trigger
event occurs.

Analog-to-digital
Gain: When a
potentiometer is
connected to the
GPIO, the selected
channel gain will
be adjusted.

Trigger Type: ‘High level trigger’ will trigger the channel
when the voltage on the pin is above the threshold. ‘Low
level trigger’ will trigger the channel with the voltage on
the pin is below the threshold.

Command: String of Hex characters that will be sent over
RS-232 upon a trigger event.

Channel: Selects which ‘Input’, ‘Output’ or ‘System’
channel will be affected by the gain change.

Trigger Type (outputs only): Determines which function will initiate a trigger event on the GPIO channel. Additional
parameters will differ depending on the Trigger Type selected. The following tables define the additional parameters
based on the value of this field.

Direction = ‘Output’

Trigger Type Value
Preset: Initiates a
trigger event when
a predefined
preset is selected.

Level: Initiates a
trigger event when
a channel level
reaches a defined
threshold.

Associated Dialog Box

Additional Parameters
Output Type: ‘Output low level” will set the channel pin
to ground. ‘Output high level’ will set the channel pin to
+5VDC.

Preset: Defines which preset, when selected, will initiate
a trigger event.

Output Type: ‘Output low level’ will set the channel pin
to ground. ‘Output high level’ will set the channel pin to
+5VDC.

Channels: Identifies which channel will be monitored.

Level: Sets the gain threshold, which when met, will
initiate a trigger event.
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Mute: Initiates a
trigger event which
mirrors the mute
state of the
predefined
channel.

Output Type: ‘Output low level’ will set the channel pin
to ground. ‘Output high level’ will set the channel pin to
+5VDC.

Channels: Identifies which channel will be monitored.
When a channel is muted it will set the channel GPIO pin
to the state defined in ‘Output Type’. When unmuted it
will revert back to the default state.

Save as...: Saves the current GPIO configuration to a file. When configuring devices offline, save the GPIO configuration

to a file before connecting to a live device. When a live device is first connected, it's onboard settings will overwrite

whatever is in the software to ensure proper sync. Once the deice is connected, this file can be applied and saved to the

device.

Open...: Opens a dialog box to select a previously saved GPIO configuration file. The configuration will be applied to the

GPIO when open.

Save: Saves the configuration to the device. This will be ‘grayed out’ when the device is not connected.

Group Setting

Both input and output channels can
be grouped together for the
purpose of gain setting and muting,
all other parameters remain
independent. Grouped channels can
be identified by a colored mark on
the channel fader, all channels in a
particular group will share the same
color. Up to 16 input and 16 output
groups are supported.

To select channels, simply click in
the intersection of the Group name
and the channel number. Note that
any one channel can only exist in a
single group.

Grouped channels only share gain and mute settings,
while Linked channels share all parameters. Keep this in
mind when creating your groups. Linked channels will still
mirror parameters other than gain and mute, however the
gain and mute settings of the Group will take precedence

over Link.

Inputs: Create Input groups.



Outputs: Create Output groups.
OK: Saves setting to device and closes the dialog box.
Clear All: Clears all group settings.

Cancel: Closes dialog box without saving changes.

Preset Name
NOTE: This menu selection is only active when a DTX device is connected to Dash.

This menu provides the facility to rename the default preset names to more standard language for easier identification.
Simply type the new names in the provided field and press ‘OK’. All the preset names will be updated on the device.

Panel Setting
DTX DSPs are designed to work natively with DTX wall panel controllers. This menu item opens a Panel creation
application that can be used to assign and customize these DTX wall panels.

User Interface
Dash software can be controlled by up to 8 PC, Android or iOS devices by creating a custom interface. This menu opens a
User Interface creation application used to create these custom interfaces.

User Admin

When connected to an active device, the Settings menu will contain an
additional item to control User Administration. This provides means to
password protect access to a DTX device. When connecting to a device
via the Device List, a dialog will appear prompting for a username and
password if Account Login is enabled. The Dash software will not
connect to this device without a username and password in this case.
Each DTX device maintains its own User Admin. NOTE: The username
and password are not required to use Dash software, only to connect
to a device. UDP control is not affected by User Admin settings.

Enable Account Login: Check this box to require a username and
password to access a DTX device via Dash.

Add User: Click the ‘Plus’ sign at the center bottom of the dialog to add a new user.
EditPassword: Click to edit the password for the selected user.

DeleteUser: Click to delete the selected user. Admin user cannot be deleted.

Edit Password
If Account Login is enabled for a device, when connected to that device, ‘Edit Password’ will appear in the Setting menu.
Selecting this option will display a dialog box to change the password for the logged in user.



Factory Reset
In the event an Admin password is forgotten, the unit must be reset to factory defaults. See Appendix B: Factory Reset
for more information.
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Help
About
Displays software version information.

Document
Help file for Dash software.

Command Capture

The Command Capture window provides an easy capture system for command strings. With the window open, simply
click or set any parameter and the command string that corresponds to that command will appear in the window. Using
the button, copy the command and use it with a third-party control system to send the command via UDP or RS-232.

Device Tabs
To the right of the Help menu are the Device tabs. Each tab

represents a separate DTX DSP device. The Device Name

appears as the text in the tab for easy identification. See ‘Device Settings’ for information on how to change the device
name. To the right of the Device name is a small status indicator which will be green if the device is connected, or grey if
it is not. A small (x) next to the name can be clicked to close the tab.

New devices can be added by clicking the (+) plus sign to the right of the last device tab. See Device List or more
information on adding devices.

Device List
The Device list is the last item on the far right of the top menu line. The device list

contains all of the active, discovered DTX devices on the network. Each device on the
network will appear in the list with details about the device. Device Name, Device IP and
software version. Below this information are two buttons.

Plus Sign: Click to manually add a device to the list by IP address.
Refresh: Click this to refresh the discovery of new devices on the network.

Connect/Disconnect: Connects the device to the active Device tab. NOTE that the active
device tab must match the device type. If the device is already connected, the button will
read ‘Disconnect’. Clicking the button in this state will disconnect the device from the
active Device Tab.

Set IP: This allows the Device IP address to be set. The list is generated by UDP discovery,

so it is possible that the IP address is not in the correct subnet for the active network. This

is especially true for new DTX devices that still have the default IP address set. The IP address must be set to and address
on the active subnet before configuration of the device. NOTE: This IP address is for the LAN interface and is different
than the IP address for the Dante Interface.
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Edit Module

Below the main software logo is the Edit Module mode button with a

pencil icon. Pressing this button enters to module edit mode where

individual DSP Modules can be added or removed from channels.

Pressing the button again, returns to normal run mode. Next to the Edit

Module button is CPU and memory load indicators. These indicate the

current load of the connected device and are used when adding

modules. NOTE: This mode is only available on certain DTX models

and is only active when a device is connected. See the section entitled Adding and
Removing DSP Modules for more information about using this mode.

Upload Parameters to Device
This is a small button to the right of the Edit Module button. Pressing this button immediately uploads the current

configuration to the connected device. This would typically not be needed in normal operation but is provided as a
debugging tool to force immediate synchronization with a device. NOTE: This button is only active when a device is
connected.

Master Slave Indicator
To the right of the ‘Upload Parameters to Device’ button is a small circle indicator. This indicates the Backup Device

status of the connected DTX device. A red S indicates the device is a slave. This is the normal indication for devices that
are not using the Backup Device functionality. When a DTX device is designated as a Host or Master in Device Setting
dialog the indicator will display a red M.
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Navigating the Home Tab

The Home tab is the main dashboard for the selected device. It is located below the Device tabs and is the first entry in
the line of Module tabs. Click the word ‘Home’ to enter the Home tab.

Channel Layout
For both inputs and outputs channels are numbered first with analog followed by Dante. Dante channels can be

identified in Dash with the Dante logo above the channel fader. This arrangement flows everywhere in the software —
channel layout, Matrix, AEC, etc, everywhere channels are referenced. NOTE Dante channel numbering will follow this
numbering scheme. Notice in the image of Dante Controller below that the DTX-44D starts with channel 5.

DTX Model Channel Layout

DTX-44D Ch 1-4 Analog
Ch 5-8 Dante
DTX-88D Ch 1-8 Analog

Ch 8-16 Dante
DTX-1616D | Ch 1-16 Analog
Ch 17-32 Dante
DTX-3232D | Ch 1-32 Dante
DTX-6464D | Ch 1-64 Dante

View of DTX-44D in Dante Controller

Selecting Channels
Clicking the channel label, fader or number will select the active channel. This will be
indicated with by teal border around the channel.

Changing the Channel Name
Channel names can be changed by double clicking on the name. Type the new name and
hit enter to save.

Setting Channel Gain
Channel Gain can be set by either moving the fader with a mouse, or by typing the value in
the gain value box directly below the fader.

Linking Channels
Two adjacent channels can be linked by clicking the ‘Link’ button between them. All parameter changes to one linked
channel will be duplicated on the second.

Channel Pages
At the bottom left and bottom right of the Dash window are buttons that can be used to page through channels. Clicking

one of these buttons will scroll the channel bank to view the selected group of channels.

Setting Minimum and Maximum Gain
By default, the minimum and maximum gain levels on the input and output faders are set to their limits of -72dB to
+12dB. Right clicking over a fader will bring up a context menu that will allow you to reduce these limits.
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Accessing Parameters
There are three ways to access parameters of a channel and its modules.

Right Click: Right clicking over a module will bring up a dialog box for the selected module and channel while staying on
the Home tab.

Double Click: Double clicking on a module will bring up either the ‘Inputs’ tab or the ‘Outputs’ tab depending on the
type of channel you have clicked. The tab will come up with the module you selected as the active window. This is
described in more detail in the next section.

Module Tabs: Channel module parameters can be also accessed by selecting either the ‘Inputs’ or ‘Outputs’ tab from
the module tabs. These tabs are described in more detail in the next section.
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Module Tabs

Below the main menus and Device tabs are a series of Module tabs. The quantity of these tabs will vary depending on
the capabilities of the DTX model you are using.

DTX Model \ Available Module Tabs

DTX-44D Inputs, AutoMixer, AEC, ANS, Matrix, Outputs, Meters
DTX-88D, DTX-1616D, DTX-3232D | Inputs, AutoMixer, AEC, ANS, Matrix, Outputs, Meters, Camera
DTX-6464D Inputs, Matrix, Outputs, Meters

The detailed functions of these modules are described later in the manual.

Inputs

The Input tab maintains the input fader section
across the bottom. Above the fader row is a
section which slides right to left and contains
all the DSP modules for the selected input
channel. Modules can be navigated by sliding
the section left to right with the mouse, or by
clicking one of the DSP Module names in the
button list at the far-right of the screen.

AutoMixer

The AutoMixer tab maintains the Input and
Output fader sections divided by the Sound
Card as in the Home tab. Above the fader row
is the AutoMix System Module.

AEC

The AEC tab maintains the Input and Output
fader sections divided by the Sound Card as in
the Home tab. Above the fader row is the AEC
System Module.



ANS

The ANS tab maintains the Input and Output
fader sections divided by the Sound Card as in
the Home tab. Above the fader row is the ANS
System Module.

Matrix
The Matrix tab maintains the Input and Output

fader sections divided by the Sound Card as in
the Home tab. Above the fader row is the
Matrix System Module.

Outputs

The Output tab maintains the output fader
section across the bottom. Above the fader
row is a section which slides right to left and
contains all the DSP modules for the selected
output channel. Modules can be navigated by
sliding the section left to right with the mouse,
or by clicking one of the DSP Module names in
the button list at the far-right of the screen.
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Meters

The Meters tab maintains the Input and Output
fader sections divided by the Sound Card as in
the Home tab. Above the fader row is a set of
input and output meters.

Camera

The Camera tab maintains the Input and
Output fader sections divided by the Sound
Card as in the Home tab. Above the fader row
is the Camera Control Module.

System Mute

To the right of the Module tabs is the System Mute and appears as a round button with a speaker. Pressing this button
performs a system mute of all channels. The speaker image will turn red when engaged. Click the button again to release

the mute.

Presets
The final item to the far right of the Module tabs is the Preset list. Clicking the drop-down list will open it to show the list

of 16 presets. Selecting an item from the list will recall the preset. The Settings menu contains the Preset Name
functionality which allows for the renaming of the presets.

The save button is used to immediately save the current configuration to the selected preset on the device. This is only

available on a connected device.

The Preset Load button loads a saved configuration file (.dsp) from the computer into the selected preset. Simply select
the preset from the ‘Preset Load’ list and an open dialog will appear. Select the file from its location and hit ‘Open’. The
configuration will be loaded into the preset on the device. See the section titled File Menu for more information about

creating a .dsp file. This is only available on a connected device.
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DSP Channel Modules

The Dash DSP Control software has been designed to be incredibly flexible and includes a large variety of DSP Modules,
each providing a unique function.

NOTE: The DTX-44D and DTX-6464D have fixed DSP modules, they cannot be changed.

Adding and Removing DSP Modules

DTX-88D, DTX-1616D and DTX-3232D allow for the customization of DSP Modules
on a per channel basis. There are five Module Slots on each input channel and four
Module slots on each output channel. Modules can be added and removed by
entering ‘Edit Module’ mode.

From the Home tab, click the Edit Mode button which has the pencil icon. Now
when you hoover your mouse over one of the module slots, the slot will be outlined
in red. Right click over the highlighted module slot to get a context menu. Using the
right menu functions configure the device. As you are configuring the device, keep
an eye on the ‘cpu:’ and ‘mem:’ indicators next to the ‘Edit Module’ button. These
indicate the current load of the device resources based on the current
configuration. If they turn yellow, resources are getting thin. If they turn red, you
have exceeded the available resources and will not be able to save the
configuration.

The following functions can be performed:
Delete: Empties the selected module slot.
Clear Current Channel: Empties all module slots in the selected channel.

Clear All Channel: Empties all input or output channels on the device, depending on whether the selected channel is an
input or output.

Copy Current Channel: Copies all the module slots on the current channel.
Copy to All Channels: Copies the current channel modules to all the other channels, either input or output.
Paste: Pastes a previously copied channel module set to the currently selected channel.

Module List: Lists all the available modules that can be used in the selected module slot. Selecting an item from the list
will fill the highlighted slot with the selected DSP Module.

When complete, click the pencil icon again to save your changes to the device. You will be prompted to either Finish,
Upload or Cancel.

Finish: Saves the changes locally in Dash but does not upload them to the connected device if one is connected. If there
is a device connected it will be discontinued as the device will now be out of sync with the Dash configuration.

Update: Saves the changes to the device. This button will be ‘greyed out’ if there is no device connected.
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Cancel: Exits ‘Edit Module’ mode and discards changes.

Input Source

The Input Source Module is a fixed module that exists on every input
channel of every DTX device. It provides basic input parameters for the
selected channel. Since this is a fixed Module, it does not consume one of
the five Module Slots available on some DTX models.

Analog Signal: Selects the analog input connected to the external analog
connection for the channel source. (Analog Inputs Only)

Digital Signal: Selects the Dante input connected to the external analog
connection for the channel source. (Dante Inputs Only)

Sensitivity: Microphone input gain selectable in 3dB increments from 0
to 48dB. (Analog Inputs Only)

Phantom Power: Provide power for external condenser microphone or
other phantom powered input peripheral. Do not enable phantom power
on a line input source or when the power is not required, so as not to
damage the external device. (Analog Inputs Only)

Phase: Reverses the phase of the input signal by 180°.
Mute: Mutes the channel.
Signal Generator: Activates the internal signal generator for the selected channel instead of the analog input.

Sine Wave: Sets the output of the Signal Generator to a sine wave with a frequency between 20Hz and 20kHz. You may
regulate the output level (unit: dBFS) based on your own needs. Use a fader to adjust or click the text field to designate a
value.

Freq: Use this slider to set the frequency of the sine wave generated. This slider has no effect when white or pink noise
is generated.

Level: Sets the level of the Signal Generator. This slider works for all three types of signal generation.

White Noise: Sets the output of the Signal Generator to white noise. White noise is a signal made of uncorrelated
samples, such as the numbers produced by a random generator. When such randomness occurs, the signal will contain
all frequencies in equal proportion and its spectrum will turn flat. The Freq slider will have no effect on the pink noise,
however the Level slider can be used to adjust the amount of signal inserted into the channel.

Pink Noise: Sets the output of the Signal Generator to pink noise. Pink noise is a random signal, filtered to have equal
energy per octave. Pink noise has equal power in proportionately wide bandwidths. The Frequency slide will have no
effect on the pink noise; however, the level slider can be used to adjust the amount of signal inserted into the channel.
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Expander

Expanders are helpful dynamic processing tools
that increase the dynamic range of an audio
signal. They are essentially the opposite of a
compressor, which decreases the dynamic
range of an audio signal. The most fundamental
difference between and expander and a
compressor is that while a compressor engages
when a signal is above a defined threshold, an
expander engages when a signal drops below a
defined threshold. An expander is a more
nuanced version of a gate in that it attenuates
low level signals below a threshold and leaves
those above alone.

Threshold: The expander engages when the signal is below this threshold.

Ratio: Sets the slope below the threshold point on the gain curve. In other words, sets the amount of expansion that is
applied.

Attack: Determines how fast the expander engages once the threshold is crossed.
Release: Determines how fast the expansion recovers after the signal returns above the threshold.

A combination of Attack and Release provides hysteresis to reduce the changing speed of gain attenuation or what is
often referred to as ‘breathing’.

ON/OFF: The Expander has a master on/off switch which is used to enable or disable the module. The effected
expansion curve will be highlighted in the graph when the module is ON.

Compressor

Audio compression reduces the dynamic range
of an audio signal. Dynamic range is the
difference between the loudest and quietest
parts of a waveform. Compression reduces
this range by attenuating the louder signals
and boosting the quieter signals. As a result,
the loudest and softest parts are closer in
volume, creating a more balanced sound. With
the extra headroom, you can then increase the
overall level of the signal.

Threshold: When the signal level is higher than the threshold, the compressor/limiter begins to reduce the gain. Any
signal that exceeds the threshold is regarded as overshoot signal, and its level will be reduced. The more the signal

exceeds the threshold, more its level is attenuated.
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Ratio: Refers to the compression ratio. The ratio determines how much attenuation to apply to a signal that has
overshot the threshold level. A lower threshold will reduce a greater portion of the signal, while a higher threshold will
reduce only the loudest peaks and leave the rest untouched. For example, a ratio of 4:1 means that for every 4 dB the
signal rises above the threshold, the compressor will increase the output by 1 dB. However, if the ratio is 1:1, no
compression will occur. Whereas a ratio of 10:1 or higher will make the compressor effectively act as a limiter.

Attack: Sets the time it takes for the compression to kick in once the signal passes the threshold. Faster attack times will
immediately clamp down on the initial transients of a sound. This is good for controlling dynamics and catching
transients that cause clipping. Whereas slower attack times allow more of the initial attack to punch through before
compression begins.

Release: Sets the time it takes for the compression to stop once the signal falls below the threshold. Faster release times
sound more natural and transparent. However, setting the release too fast can cause a “pumping” effect and other
unnatural sounds. Whereas longer release times are good for smoothing out dynamics.

Output Gain: This is also called gain compensation fader. If the compressor significantly reduces the level of the signal, it
may be desirable to boost output gain to compensate.

G.R. and Output Level Meter: G.R. indicates the amount of Gain Reduction (compression) applied; Output refers to the
output level of the signal that has passed through the compressor module. The compression amount is displayed in an
inverse level meter. If the input signal and threshold are set as -6dB and -30dB, respectively, and the ratio is 2:1, then
the compression amount is 12dB; G.R. level meter will indicate around -12dB and output meter around -18dB.

ON/OFF: The Compressor has a master on/off switch which is used to enable or disable the module. The effected
compression curve will be highlighted in the graph when the module is ON.

Automatic Gain Control (AGC)

Automatic Gain Control (AGC) is similar

to a compressor, except while a

compressor reduces the dynamic range

of a signal, an AGC maintains the

dynamic range while automatically

boosting the signal level. The purpose

of an AGC is to improve or normalize

signal level while maintaining the

dynamic range. For example,

normalizing the level of audio playback

of background music so that it is not

drastically different than the level of a

paging microphone, or, establishing a consistent audio between varying microphone levels in a conference. The AGC
includes silence detection to prevent wild gain swings during silent periods.

Threshold: When the signal level is lower than the threshold, the input-to-output ratio is 1:1. When the signal level is
higher than the threshold, the input-to-output ratio changes according to the ratio control settings. The threshold will



typically be set just above the noise floor. This assures that the noise floor itself will not trigger the AGC, but any signal
above that will.

Ratio: Sets the desired ratio between input signal and output signal.

Target Threshold: Sets the desired output signal level. If the signal is higher than the threshold, the controller will
compress the signal in proportion.

Attack: Sets the time it takes for the AGC to kick in once the signal passes the threshold.
Release: Sets the time it takes for the AGC to stop once the signal falls below the threshold.

ON/OFF: The AGC has a master on/off switch which is used to enable or disable the module. The effected gain curve will
be highlighted in the graph when the module is ON.

Parametric EQ

A Parametric Equalizer is an adjustable

filter used to shape a signal’s frequency

content. The Parametric EQ allows control

of multiple frequency bands and has

adjustable parameters to control the

center frequency, the gain or attenuation

of that frequency and the Q (Quotient of

Change) aka bandwidth around that

frequency that is affected. While it is more

complex than other types of equalizers, a

Parametric EQ provides surgical precision

and fine adjustment. For example, the squeal of a running air conditioner could be eliminated from a microphone signal
without drastically effecting the desired audio content by using a very narrow Q with significant attenuation at the exact
frequency of the squeal. The Dash software provides incredibly flexibility by offering 5, 8 and 12-band Parametric EQ
modules (not available on all hardware).

Type: Parametric EQ is a default. High & low shelf filters and high & low pass filters can also be selected. Each kind of
filter has different frequency shapes to achieve different functions.

High & Low Pass Filter: The reference frequency of pass-type filter is called the cut-off frequency. Pass-type filter allows
the frequencies on one side of the cut-off frequency to fully pass the filter while the frequencies on another side of the
cut-off frequency are attenuated. A high pass filter allows the frequencies above the cut-off frequency to pass and filters
the frequencies below the cut-off frequency, while a low pass filter allows the frequencies below the cut-off frequency
to pass and filters the frequencies above the cut-off frequency.

High & Low Shelf Filter: High shelf filter means that the gain enhances or attenuates for the frequencies above the set
frequency. Low shelf filter means that the gain enhances or attenuates for the frequencies below the set frequency. The
set frequency is not the 3dB cut-off frequency but refers to the center of the failing edge or rising edge of the filter. Q

value affects the peak and has a mathematical relationship to the peak.
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Frequency (Hz): Sets the center frequency of the filter.
Gain (dB): It refers to the amount of gain or attenuation applied at the center frequency.

Q : Q Represents ‘Quotient of Change’ or the bandwidth. This sets how wide a swath of frequencies are affected
surrounding the center frequency. The adjustable range of Q value is 0.02-50.

When the filter is a parametric EQ filter, Q value refers to the width of the bell-shaped frequency response curve on
both sides of the center frequency.

When the filter is a high & low shelf filter or a high & low pass filter, if Q>0.707, there will be peaks in the filter
responses. If Q<0.707, the slope will become flatter, and the roll-off will occur in advance.

OCT: Changes the units from Q-value to octaves. When dealing with music content, measuring bandwidth in terms of
octaves can provide more musical results. A wider octave setting will make the content more natural and musical, on
narrow settings it allows you to know the musical notes you are affecting as determined by the center frequency.

ON/OFF: Each segment of equalizer has a switch which is used to turn on or turn off the corresponding segment. If set
to OFF, the parameter position is disabled. The Parametric EQ has a master switch located on the far left, which is used
to enable or disable the entire module. The effected frequency response curve will be highlighted in the graph when the
module is ON.

Graphic EQ

Like the Parametric EQ, the Graphic EQ is an adjustable filter used to shape a signal’s frequency content. The Graphic
EQ, however, is far simpler. Unlike the Parametric EQ, the Graphic EQ has its frequencies, and Q (bandwidth) fixed. Each
fixed center frequency has its own gain control. There is one important thing to understand about graphic equalizers.
When you adjust a slider, it also affects the neighboring frequencies. The Dash software provides incredibly flexibility by
offering 10, 15and 31-band Graphic EQ modules (not available on all hardware).
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Frequency Bands: Gain control for the specified frequency. Value ranges are from +12 dB to -24 dB (attenuation).
Narrow/Normal/Wide: Selects from one of three preset Q-values. This setting applies to all frequency bands.
Reset: Resets gain values for every frequency band to 0 dB and turns OFF the Graphic EQ module.

ON/OFF: The Graphic EQ has a master on/off switch which is used to enable or disable the module. The effected
frequency response curve will be highlighted in the graph when the module is ON.

Adaptive Feedback Control (AFC)

The Adaptive Feedback Control (AFC) module automatically detects and inhibits audio feedback. The module
differentiates undesirable feedback from the desired audio content based on specific characteristics of the audio signal.
When a feedback instance is detected, a notch filter (narrow Q) will be automatically added at the center frequency of
the feedback. The applied attenuation is progressive meaning it starts with minimal attenuation at the feedback
frequency, slowly increasing the attenuation, in compliance with the set parameters, until the feedback is eliminated or
falls below the Feedback Threshold value.

Once a feedback event has been handled and the notch filter engaged, the filter will be locked to prevent change. These
filters can be duplicated in a channel equalizer for a more permanent fixed feedback solution. There are eight (8), twelve
(12) or sixteen (16) narrow-band filter slots in an automatic cycle depending on which AFC module was selected. Eight is
the default.

Panic Threshold: Positively defines a feedback event. Any signal above the Panic Threshold will be considered feedback.
When a signal level exceed the Panic Threshold any of the following will occur to attempt to get the feedback under
control:

e Gain will be attenuated to attempt to control the feedback
e The output of the AFC module will be limited to prevent runaway feedback
e The filters sensitivity will be increased to provide faster detection
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When the signal returns to below the threshold, all settings are returned to their pre-feedback event state.

Feedback Threshold: Positively defines what is NOT a feedback event. Any signal that is below this threshold is not
considered feedback. Setting this threshold too high can diminish the effectiveness of the AFC.

Filter Depth: Sets the maximum attenuation of a single filter. A low setting will minimize the effect on the overall signal;
however, it will also diminish the effectiveness of the AFC.

Step: Sets the Notch Depth Step Size (dB). Defines the depth of correction of each step. When a new feedback event
occurs, the initial depth of the notch filter is set to twice this value. If the feedback persists, the notch will be deepened
be this amount at regular intervals until the feedback is mitigated or the Filter Depth is reached. Larger values can cause
‘over-correction’ of the problem. In general, larger rooms should use smaller steps as the delay time of the room will
cause the feedback to take longer to dissipate.

Bandwidth: 1/10 and 1/5 octave can be selected. A constant Q value applied to the notch filter, the filter will not
become wider due to the increase of depth. A value of 1/10 octave should be used by default as it is narrower, it will not
affect the desired signal as much as the 1/5 octave bandwidth. If feedback is persistent, the bandwidth can set at 1/5
octave because it has wider bandwidth and can catch more feedback events. The tradeoff, however, is that the notch
filter will be more noticeable in the desired signal content.

Dynamic/Manual: Each of the notch filters can be set to either Dynamic or Manual mode. The default should be
Dynamic as that will utilize the built-in content analysis and feedback detection algorithm. The Manual setting will
effectively turn the related channel into a parametric EQ channel. Center frequency and gain can be manually set, and
the Q-value is selectable using the 1/5 or 1/10 octave buttons.

Clear: Click the button to instantly clear all notch filters. This operation is generally done when recommissioning the AFC
module.

Commissioning

The AFC module can be used as a tool during system commissioning to identify feedback points or as a preventive
measure during normal operations. To maximize channel gain and AFC effect, use the following steps to set up the AFC.

1) Reduce the channel volume, and use the button "Clear All" to reset all notch filter parameters

2) Set up parameters for the feedback inhibition module as desired. Start with a low Panic Threshold to make sure
you can identify all feedback events.

3) Open all microphones, and slowly increase channel volume until the feedback occurs. Stop increasing channel
volume when the feedback occurs.

4) Wait for the AFC module to take effect; after the feedback disappears, continue to increase gain.

5) Repeat the operation until the system reaches the required gain or until all filters are fully distributed

6) Change the Panic Threshold to a maximum level just higher than the expected non-feedback signal.

After initial setup, notch filter setting can be transferred to a channel Parametric EQ for permanent suppression, freeing
up the notch filter for any potential new feedback event that could occur in the future.
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If a speaker is included among the devices used, it is recommended to use a compressor/limiter module on those
outputs for additional protection. You should set an appropriate limiter to make sure that the speaker will not get
damaged even if all notching filters slots are used or the feedback inhibitor cannot effectively control the feedback, such
as in the case of excessive system gain.

ON/OFF: The AFC has a master on/off switch which is used to enable or disable the module. The effected frequency
response curve will be highlighted in the graph when the module is ON.

Gate

The primary purpose of a Gate is to clamp off

signals below a defined threshold, typically

noise. Beyond just controlling IF a signal can

pass through a channel, a Gate can also control

how quickly the signal is allowed to pass, how

long the Gate stays open and how soon the Gate

can be fully opened again. Gates can be used in

a couple of ways. First, they can be used to

reduce unwanted external sounds. Think of

someone speaking into a microphone in a busy

office environment. You can use a Gate to

reduce or eliminate the background noise when they are not speaking. Secondly, they can reduce natural channel noise.
All audio equipment has an inherent noise floor. A Gate can be used on a channel where one of these devices is
connected, to silence the noise when the device is silent.

. _ gate open

Threshold: Any signal greater than the Threshold value will open the - .
. Kl "hold time.
Gate, below the Threshold will close the Gate. allack fime hold time.
-2,_3 release time
o - =

Depth: Determines how much attenuation below the Threshold will be Sl
applied to gated signal. ... threshoid

Attack: Sets how quickly the Gate will open after the signal exceeds the
Threshold. o time
B As processed

Release: Sets how quickly the Gate will close after the signal drops Original

below the Threshold and after Hold has expired. Release is the key to a
natural sounding audio decay.

Hold: Sets the time the Gate will stay open after the Threshold has been passed. This can be important on signals with
fast varying levels. A longer Hold value will keep the Gate from producing an audible ‘chatter’ in this scenario.

ON/OFF: The Gate has a master on/off switch which is used to enable or disable the module. The effected gain curve will
be highlighted in the graph when the module is ON.



Ducker

A Ducker is a device used for lowering the
level of one audio source based on the
presence of another audio source. Duckers
are often used in paging systems to lower
the level of background music during a
page. In this application, the Ducker
restores the background music once the
page is completed.

Reference Source: Sets the source channel
used to trigger the Ducker. This can be more than one channel.

Threshold: When the reference source exceeds the Threshold, the Ducker engages.
Depth: Determines how much attenuation below the Threshold will be applied to ducked signal.
Attack: Sets how quickly the Ducker will engage after the reference source exceeds the Threshold.

Release: Sets how quickly the Ducker will release after the reference source drops below the Threshold and after Hold
is expired.

Hold: Sets how long the Ducker will stay engaged after the reference source drops below the Threshold.

ON/OFF: The Ducker has a master on/off switch which is used to enable or disable the module. The effected gain curve
will be highlighted in the graph when the module is ON.

Ambient Noise Compensation (ANC)

Ambient Noise Compensation (ANC) automatically adjusts the volume of the channel to compensate for ambient noise
in the space. This is achieved through a sophisticated algorithm which listens to the ambient noise via a dedicated
microphone. For example, consider music and announcements in a bar or restaurant setting. When the bar is empty, the 5



ambient sound is low and thus, the program (music/announcements) do not to be too loud. As the bar fills, the ambient
noise gets louder, and the program will get drowned out in the noise floor of the room. ANC can compensate for this by
actively ‘listening’ to the ambient in the room and adjusting the volume accordingly.

Reference Source: Sets the source channel used as the ‘listener’ for ANC. This can be more than one channel, for
example multiple microphones in a large space.

Maximum Gain: Sets the maximum amount gain that will be applied to the channel.
Minimum Gain: Sets the minimum gain level for the channel signal.

Gain-Sense Ratio: Sets the ratio of attenuation or gain.

Speed: Sets the speed that the ANC makes a gain correction.

Trim: Adds gain or attenuation to the resulting output of the ANC.

Noise Threshold: Level of the Reference Source above which the ANC is engaged.
Distance: Sets the physical distance between Reference Source and local signals.

ON/OFF: The ANC has a master on/off switch which is used to enable or disable the module. The effected gain curve will
be highlighted in the graph when the module is ON.

High and Low Pass Filter

Each output channel has a High and Low Pass Filter (Filter). A pass filter is a
useful tool in audio mixing. That’s because, unlike other EQs which turn
frequencies up or down, a pass filter allows you to filter out portions of
the frequency spectrum. There are two main types of pass filters, high-
pass filters (HPF) and low-pass filters (LPF). A high-pass filter, also referred
to as a ‘low-cut filter’, does exactly what the name suggests. It allows only
frequencies that are higher than a certain point to pass through.
Simultaneously, it filters out the frequencies that are lower than that
point. A low-pass filter, also referred to as a ‘high-cut filter’, allows only
frequencies that are lower than a certain point to pass through. Simultaneously, it filters out the frequencies that are
higher than that point.

Frequency: The cutoff frequency of filters. The cutoff frequency of Bessel and Butterworth is defined at -3 dB, and the
cutoff frequency of Linkwitz-riley is defined at -6dB.

Gain: Sets the gain or attenuation applied to the signal.
Type: There are three types of filters including Bessel, Butterworth, and Linkwitz-Riley.

The purpose of the Bessel filter is to achieve approximately linear phase, linear phase being equivalent to a time delay.
This is the best phase response from an audible standpoint, assuming you don't want to correct an existing phase shift.
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The Butterworth filter is a type of signal processing filter designed to have as flat frequency response as possible (no
ripples) in the passband and zero roll off response in the stopband. However, one main disadvantage of the Butterworth
filter is that it achieves this pass band flatness at the expense of a wide transition band as the filter changes from the
pass band to the stop band. It also has poor phase characteristics as well.

The Linkwitz-Riley filter concept came from cascading pairs of identical two-pole Butterworth filters in low pass and high
pass configurations. The result is a crossover filter that uses the same corner frequency in high pass and low pass, has no
peaks or dips and is phase continuous at the crossover frequency. In other words, at the crossover frequency, both
drivers are in phase, each contributing half the energy they would in their passbands.

Slope: It refers to attenuation values of transition zone of filters. There are totally 8 attenuation values including 6, 12,
18, 24, 30, 36, 42 and 48dB/Oct. For example, 24dB/Oct indicates that the attenuation range is 24dB for each octave
difference existed in frequency in transition zone.

Users may click bottom activate button to activate high- or low-pass module.

ON/OFF: The Filter has two on/off switches which are used to enable or disable the High Pass and Low Pass Filters
independently. The effected frequency response curve will be highlighted in the graph when the module is ON.

Delay

The Delay Module inserts delay into the output of the selected channel. Delay is often
used in DSP processors for the purpose of time alignment. This can be either for time
alignment of speaker elements if the outputs are used to drive different speaker drivers,
or to align an audio output to a video source. In a multi-element loudspeaker or array, the
sound from different drivers will take slightly different amounts of time to reach your
ears. Since a woofer cone is "deeper" than a tweeter, the acoustic center of the woofer is
further away from the listener's ear than the tweeter. The sound from the woofer will
therefore arrive at the listener's ear slightly later than the sound from the tweeter. This
can have a detrimental effect on the speaker's response around the crossover. The Delay
Module can delay the output signal destined for the tweeter by a small amount of time. The result is that the acoustic
waveform from both drivers will arrive at the listener's ear at the same time.

Milliseconds, Meters and Feet: All these parameters are linked, they display the same delay time measured in three
different units. Entering a value in any one of the parameters will automatically be converted to the other units of
measure and filled in.

Delay Slider: Provides a graphical way to enter the delay value.

ON/OFF: The Delay has a master on/off switch which is used to enable or disable the module. The ‘Delay’ indicator will
be green when the module is ON.

40



Output Setting

The Output Setting Module is a fixed module that exists on every output channel of
every DTX device. It provides basic output parameters for the selected channel. Since
this is a fixed Module, it does not consume one of the four output Module Slots available
on some DTX models.

Phase: Reverses the phase of the output signal by 180°.

Mute: Mutes the output.
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DSP System Modules
Gain Sharing Auto Mixer

The Dash Gain Sharing AutoMixer is a multichannel mixer that automatically lowers the level of non-active audio sources
such as microphones while simultaneously riding the level of active sources to maintain the desired target gain. This
eliminates the need for tedious and often impractical live mixing of audio sources. The alternative is to just leave all
source channels open, however that can severely degrade the overall quality and user experience allowing hum,
background noise, etc. from inactive open microphones to be mixed with the desired signals. The Dash Gain Sharing
AutoMlixer solves that problem elegantly by using the intelligence of the DSP to optimize the audio mix, prioritizing
desired content while diminishing undesired content.

Gain Sharing provides the most natural sounding mix of multiple microphones. Some AutoMixers use gating technology
to gate inactive microphones while maintaining a defined maximum Number of Open Mics (NOM). While this technique
functionally ‘works’, one can imagine the unnatural sounding result as microphones are being effectively muted and
unmuted during conversation. A Gain Sharing Automixer uses mathematics to reduce the individual gain of a
microphone as microphones are added. Fundamentally, for every doubling of the NOM, the AutoMixer reduces the
overall gain by 3dB. The effect is a seamless, natural, and conversational sounding mix.

There are two groups of control parameters in the Gain Sharing AutoMix module: main control parameters and channel
control parameters.

Main Control Parameters
Gain: Sets the desired target gain for the output of the AutoMix.

Slope: Determines how aggressive the gain sharing is. Low Slope settings cause the module to behave
just like a conventional mixer. High slope settings cause the inputs to attenuate more deeply for inactive
microphones, similar to a gate. A value of around 2.0 provides the most natural sounding effect in most
applications.

Response: Sets the speed at which the AutoMix operates. A faster response time may be needed if

different speakers are speaking in quick succession however a response value that is too fast could

cause unwanted ‘pumping’ of the audio between spoken words. Conversely, too slow of a response

could cut off the beginning sounds of words. However, the very nature of the Gain Sharing algorithm

provides for a faster on time than off, to help prevent this effect, even at very fast Response settings.

Practice shows that the most natural effect will be produced with a Response value between 100ms and 1000ms.
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Mute: Mutes the output of the AutoMixer.

ON/OFF: The Auto Mixer has a master on/off switch which is used to enable or disable the module. The ‘Gain Sharing
AutoMix’ indicator will be green when the module is ON.

Channel Control Parameters

Fader/Gain: Sets the channel gain. Faders can be used to tell the Gain Sharing algorithm the desired
relative level of each channel. NOTE: Channel gain is after the input to the AutoMix engine. Channel level
may still influence the gain adjustment of other channels even if the fader is all the way down.

Priority: Sets the priority level of the selected channel. This value feeds into the AutoMix engine and can
influence automatic gain adjustment decisions. Priority values range from 0 to 10. The higher the value
the higher the priority of the channel.

AutoMixer: Enables AutoMix participation of the selected channel.

Mute: Mutes the channel. NOTE: Mute is after the input to the AutoMix engine. A muted channel may
still influence the gain adjustment of other channels in the AutoMix.

AutoMixer Application Notes

Both channel gain and channel mute in the AutoMix module are after the AutoMix engine in the signal chain. Therefore,
as long as the channel is participating in the AutoMix it will influence the algorithm — even if the channel is muted or the
gain is all the way down.

If two or more channels have the same signal level, the channel with the highest priority will get more auto gain. It
should be noted that great care should be given when assigning priority values. It is best to avoid wide differences in
between channel priorities for example 0 and 10. If the channel with a value of 10 can recognize even background noise
as valid content and then channels with a priority of O could be masked all together and never added to the AutoMix.
This effect gets worse with higher Slope values. If it is necessary to have such diverse priorities, it is recommended to
add a gate or expander to the highest priority channels to eliminate unwanted noise.

Gating AutoMixer
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In addition to a Gain Sharing AutoMixer, Dash provides the option of a more traditional Gating AutoMixer (Relative
Threshold). When in Edit Module mode, right clicking on the AutoMixer slot in the top center of the Home Tab, provides
the option of using either a Gain Sharing AutoMixer or a Gating AutoMixer.

As the name implies, a Gating Auto Mixer employs active noise gates to only allow active channels to go through and
prevent inactive channels from contributing to the overall mix. A channel is considered active if it is able to breach the
threshold set for the noise gate.

Main Control Parameters
Gain: Sets the desired target gain for the output of the AutoMix.

Hold: Sets the amount of time a channel remains open after the signal on that channel falls below the Noise Threshold.
This ensures that a slight pause when speaking does not close the channel.

Off Gain: Sets the amount of attenuation when the channel is inactive/closed. It does not affect the AutoMix logic.
Setting this value too high will allow a room noise and echo on the gated channel to come through.

Sensitivity: Determines how far above the Noise Threshold the channel must be to open the gate.

NOM Atten: Sets the logarithmic attenuation of the output based on the Number of Open Mics. The output is
attenuated by this value each time the NOM doubles. For example, if the value is set to 3dB, then when there are two
open mics (NOM = 2) the attenuation is 3dB. When NOM equals 4 then 6dB of attenuation is applied, NOM equals 8
then 9dB, etc.

NOM Limit: Sets the maximum number of open microphones (channels) allowed at any given time.

Noise Threshold: Noise Floor Tracking follows the steady or slowly changing noise of equipment fans, HVAC, and so on.
In order for a channel to open its gate, the signal must exceed the Noise Threshold control.

Last On: Leaves the last channel that was used in the open condition, until another channel signal exceeds the
Threshold.

Mute: Mutes the output of the AutoMixer.

ON/OFF: The Auto Mixer has a master on/off switch which is used to enable or disable the module. The ‘Gain Sharing
AutoMix’ indicator will be green when the module is ON.

Channel Control Parameters

Fader/Gain: Sets the channel gain. Faders can be used to tell the Gain Sharing algorithm the desired relative level of
each channel. NOTE: Channel gain is after the input to the AutoMix engine. Channel level may still influence the gain
adjustment of other channels even if the fader is all the way down.

Priority: Sets the priority level of the selected channel. This value feeds into the AutoMix engine and can influence
automatic gain adjustment decisions. Priority values range from 0 to 10. The higher the value the higher the priority of
the channel.
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AutoMixer: Enables AutoMix participation of the selected channel.

Mute: Mutes the channel. NOTE: Mute is after the input to the AutoMix engine. A muted channel may still influence the
gain adjustment of other channels in the AutoMix.

Default: Sets the default channel. When all other channels are gated, the single default channel will be opened.

Acoustic Echo Cancellation (AEC)

Acoustic Echo Cancellation (AEC) is important
for audio teleconferencing when simultaneous
communication (or full-duplex transmission)
of speech is necessary. In acoustic echo
cancellation, a measured microphone signal
contains two signals: the near-end speech
signal (program or local) and the far-end
echoed speech signal (reference or remote).
The goal of AEC is to remove the reference
signal from the microphone signal so only the
program signal is transmitted.

AEC is not just useful in telephony applications; they can be used anywhere one signal (remote) needs to be removed
from a second signal (local). For example, consider a drive-thru ordering system at a restaurant. The person taking the
order (remote) speaks into a microphone and that audio is broadcast so the person in the car (local) can hear it. The
audio coming from the speaker is in a unique acoustic environment. The audio can reflect off the car, the curb, other
building and back into the talk back microphone. The order taker would hear back everything they said as an echo. By
implementing AEC, the remote audio from the order taker can be subtracted out of the talk back mic audio, eliminating
the echo.

Local Input: Selects the source or sources which contains the desired audio signal as well as unwanted echo from the
remote audio signal.

Remote Input: Selects the source or sources for the audio signal which will be subtracted from the Local Input.

Non-Linear Processor (NLP): Sets the ‘tail time’ in the NLP. The ‘tail time’ is the length of time the reference (or remote)
signal will be compared with the program (or local) signal and used for echo estimation. If the AEC has an NLP value
shorter than the length of the longest echo, echo will still be heard in the program signal. The following preset values
can be selected:

Selection Tail Time

Conservative 128ms
Moderate 256ms
Aggressive 512ms
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ON/OFF: The AEC has a master on/off switch which is used to enable or disable the module. The ‘AEC’ indicator will be
green when the module is ON.

Note: Use the output of the AEC to route the resulting audio in the Matrix. Do not add the both the AEC and the local
source into the Matrix together or the desired effect will be lost.

Automatic Noise Suppression (ANS)

Automatic Noise Suppression (ANS) module can remove
audio that it detects is noise. It utilizes an intelligent
algorithm which distinguish human voice from other
sounds and treats the latter as noise. The noise is then
subtracted from the original audio source.

Input Selection: Selects source or sources for ANS.

Level: Sets the attenuation of the non-human voice audio.

Value Attenuation

Mild 6dB
Medium 10dB
Aggressive | 15dB

ON/OFF: The ANS has a master on/off switch which is used to enable or disable the module. The ‘ANS’ indicator will be
green when the module is ON.

Matrix

The Matrix in the Dash software is the heart of the DSP. It is a true mixing matrix and has dual functions. At the most
basic level it is a signal router. Simply clicking at the intersection of an input and output routes the input to the output. A
blue highlight indicates a route point.

The Matrix can also be used as an audio mixer. If it desired to route two or more inputs to the same output, simply click
the intersection of all desire inputs to the desired output. The selected input channels will be mixed and routed to the
selected output. Additional balance control of the input channels can be achieved by right clicking the blue intersection
point. This will bring up a small fader window where the amount of input signal can be adjusted. The resulting
adjustment will be displayed at the intersection. If the intersection has no text, that indicates a gain adjustment of OdB.
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Camera Tracking

The Camera Tracking tab is split into two distinct functional categories. The first two sections are tied together to
configure Automatic Voice Tracking Cameral Control. The two sections to the furthest right of the panel function as live,
Manual Camera Control.

The Automatic Voice Tracking Camera Control is an advanced and highly flexible feature which allows for seamless
automation of camera switching to provide ‘broadcast-like’ production of meetings and conferences. Every input on the
DTX device can be used as an activation trigger. All enabled inputs are monitored for activity. When the signal level
exceeds the preset Tracking threshold a camera preset can be changed and/or a custom serial command can be sent.
For example, a preset can be sent to change the preset of a camera and simultaneously send a command to an Aurora
VTX decoder or a video switcher to change which camera is being displayed.

Voice Tracking

Threshold: Sets tracking threshold. When the signal from an enabled channel
exceeds the tracking threshold, the camera tracking settings for that channel are
executed.

Default Channel: Sets the default channel. When all other channels are below the
threshold, the camera tracking settings for the Default Channel are executed.

Reaction Time: Sets the amount of time a signal must be above the threshold
before executing a camera tracking setting.

Hold Time: Sets the shortest length of activation before another trigger is executed.
When a person begins speaking the camera can be repositioned to view them after Reaction has expired and will remain
on them at least as long as defined in Scroll Time.

Send Interval: Sets the interval between successive consecutive camera commands.
Send Repeat: The number of consecutive times a camera command is sent.

Enable: Enables Automatic Voice Tracking Camera Control.
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Channels

This section is used in conjunction with the Voice Tracking settings.
Each input channel in the DSP can be selected and optionally
enabled to participate in the Automatic Voice Tracking Camera
Control.

Channel No: Selects the current input channel.

Priority: Sets the priority for the selected input channel. If multiple
channels exceed the Trigger threshold, the highest priority channel
will have its camera control settings executed. A lower number has
a higher priority.

Channels

All the following parameters apply to the channel selected above in Channel No. Every channel has its own set of

parameters.
Serial Type: Selects either RS-232 or RS-485 for camera communication.
Camera Address: The address of the camera that will be associated with the selected input channel.

Protocol: Communication protocol for the camera associated with the selected input channel.

Preset: Selects which camera preset will be triggered. These are presets on the camera and are defined using

the procedure defined by the camera manufacturer.

Enable: This indicates that the selected input channel is participating in Automatic Voice Tracking Camera
Control by sending camera presets. This can be used in conjunction with Custom Command.

Custom Command

All the following parameters apply to the channel selected above in Mic No. Every channel has its own set of

parameters.

Serial Type: Selects either RS-232 or RS-485 to communicate with an external device.
Command Textbox: Enter the command string to be sent to an external device.
Send: Immediately sends the command when pressed.

Enable: This indicates that the selected input channel is participating in Automatic Voice Tracking Camera
Control by sending a custom command. This can be used in conjunction with camera presets.

Save: Saves all the Automatic Voice Tracking Camera Control settings to the connected DTX device.
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Live Controls

This section of controls is separate from the Automatic Voice Tracking
Camera Control functionality. These parameters allow direct live control
of the camera. This can be useful in creating camera presets to be used in
Automatic Voice Tracking Camera Control without having to use a third-
party application.

Camera Control

Serial Type: Selects either RS-232 or RS-485 for camera
communication.

Camera Address: The address of the camera that will be
associated with the selected input channel.

Protocol: Communication protocol for the camera associated with the selected input channel.
Camera Speed: Sets the PTZ speed of the camera.

Camera Control Buttons: Provides control capability over the connected camera including pan, tilt, zoom focus
and iris settings.

Camera Presets

Preset: Selects the active camera preset.

Call: Send preset change message to the camera.

Save: Saves the current camera settings to the selected preset on the camera.
Clear All: Clears all camera presets.

USB Soundcard
PC or MAC USB Sound Driver

At the most basic level, a USB connection to a DTX DSP can be used as a sound card with a PC or Mac using a generic HID
audio. The driver will appear as a “Crestone USB Soundcard” in your computers sound settings. The USB connection
shows up in the Matrix as both an input and an output for routing and mixing audio. Connecting a DTX device to a
computer via USB requires a USB Type-A to USB Type-A cable which is included in the box. This is the perfect solution for
using the DTX as a source for conferencing applications such as Zoom or Teams.

USB Soundcard Module

The USB Soundcard is a system module built into all DTX hardware and can be used for both playback and recording.
This module allows playback and recording without the need for external software. When connected to a computer via
USB, audio files stored on the computer can be added to the playlist and played on the connected computer. Similarly,
the module can be used to record audio to a storage location on the PC.
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Appendix A: Device Mirroring

Some DTX models support device mirroring. This provides real-time synchronization of configuration between a Master
and Slave DSP. In the event of a catastrophic failure of the Master DSP, the functionality will switch over to the Slave DSP
within 3 seconds. This feature is configured in the Device Setting menu.

Appendix B: Factory Reset

There are times it may be necessary to restore a DTX to factory defaults. One primary example is if User Administration
is enabled, and the user password is forgotten. Factory reset can be performed via UDP command to the unit.

1) Verify that the firmware version of the DTX is at least 2.1.210611 or above.

2) Send the Factory Reset hex command via UDP to port 6001 of the DTX unit using a UDP sender app such as Packet

Sender or Hercules. The Factory Reset code can be found on a sticker affixed to the DTX. The code can be identified as
starting with 'A5'.

If your DTX does not have such a sticker, for security reasons, you will need to contact Aurora support to obtain the
code.
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https://www.hw-group.com/software/hercules-setup-utility

Appendix C: Control Protocol

External Control
All DTX DSP devices can be controlled through external third-party controllers which support UDP or RS-232. All DSP

parameter setting, and reporting is supported as well as preset recall.

When using UDP control, the default port is 50000. When using RS-232 control, the default baud rate is 115200, 8 bits, 1
stop bit and no parity. Keep in mind that for stable RS-232 communications, the interval between messages should be
greater than 100ms. All port settings can be modified in the ‘Device Setting’ menu to suit your application.

In the event that the external controller expects a reply, turn on ‘Center Control Response’ in the ‘Device Setting’ menu.

Control Protocol
There are two versions of the DTX control protocol referred to as V1 and V2. V1 is the default protocol that is used by

the DTX software. These are the Hex strings that can be obtained using the Command Capture feature of the Dash
software. V1 messages are always 12 Bytes in length and are designed to address single channels or modules in a quick
concise manner.

The V2 protocol is a variable length protocol and is primarily designed to address multiple input or output channels at a
time. In addition, V2 supports some useful system commands.

For most remote automation tasks, V1 will be preferred.

V1 Protocol

Protocol Header

b[0] b[1] b[2] b[3]
0xB3 Message Type Checksum Version

Message Start: 0xB3 indicates start of message.
Message Type (b[1]): Defines the type of message as follows

Value ‘ Function
0x21 Parameter SET
0x22 Parameter GET
0x13 Preset SET
0x74 Other Controls

Checksum (b[2]): All Bytes b[0] thru b[11] are summed, with b[2] set to 0x00. The LSB is the checksum and that value is
inserted in to b[2].

Version: Provided for legacy purposes. This value should always be 0x00 for V1 communications.
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Message Type = Parameter SET (0x21)
For Parameter Set operations, bytes b[4] thru b[11] will be in the following format:

b[4] b[5] b[6] b[7] b[8] b[9] b[10] b[11]
Module ID Parameter Type Parameter 1 Parameter 2

( IMPORTANT \

Bytes b[4] — b[11] are treated as 16 bit WORDs with the lower positioned byte being the LSB
and the higher byte position being MSB. So, for a message directed to an Input Channel, the
Message Type is 0x012B. In this case, b[4] shall be set to 0x2B and b[5] set to 0x01. This
\ convention remains true for Parameter Type, Parameter 1 and Parameter 2 values. )

e Module ID: The Module ID defines which channel or module in the DTX that is being addressed. These
Module IDs can be found in Control Type = Debug (0x09)

Enables debugging via the serial port.

b[4] b[5] b[6] b[7] b[8]-b[11]
0x07 0x00 Reserved Reserved Enable

Length: Length byte (b[2]) will always be 0x08.

Enable: When debugging is On, the system will output the runtime log to the serial port. 0x01 =
Debugging On, 0x00 = Debugging Off.
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Appendix D: Module Types. Note that some module IDs are channel specific. Each channel of the Module has a distinct
Module ID. These are sequential and cover 32 channels. For example, Input Channel EQ has a Module ID for channel 1 of

0x0061and goes through 0x0080 for channel 32. So, to address the EQ on input channel 12, you would use Module ID
0x006C.

Parameter Type: Within each Module ID table are the Parameter Types. For example, to activate phantom power on an
input channel, you would use Module ID 0x012B with a Parameter Type of 0x0004.

e Parameter 1 and Parameter 2: Parameter meanings and values can be found in each Module ID table in
Control Type = Debug (0x09)

Enables debugging via the serial port.

b[4] b[5] b[6] b[7] b[8]-b[11]
0x07 0x00 Reserved Reserved Enable

Length: Length byte (b[2]) will always be 0x08.

Enable: When debugging is On, the system will output the runtime log to the serial port. 0x01 =
Debugging On, 0x00 = Debugging Off.
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Appendix D: Module Types under their respective Parameter Type. Not all Parameter Types use both Parameter Values.
In this case, the unused parameter position gets set to 0x0000. There are several types of value types used in defining
parameter values.

e Boolean: Either 0x0000 or 0x0001. Used to defines states such as On, Off, Enable, Disable. NOTE: Be sure to
reference the Module ID tables for the correct representations. Some ‘On’ values equate to 0x0001 while other
‘Enable’ values equate to 0x0000.

e Integer: Simply the Integer representation of a HEX value. For example, 0x01A4 equates to the Integer 420.

e Zero Based Integer: This is typically used for channel identification. The HEX value is simply treated as an integer
representing a channel number where channel 1 = 0x0000, channel 2 = 0x0001, etc.

o Signed Integer: The HEX value is treated as a signed Integer. For example, a value of OXFFE8 equates to an
integer of -24.

e Signed Integer / 100: This is generally used for values which require a decimal value such as Gain. To set gain to
-6.21dB, the HEX value of 0xFD93 would be used, were 0xFD93 equates to a signed integer of -621 which when
divided by 100 equals -6.21.

e Matrix Point: This is the only parameter value where the data is treated as BYTEs instead of WORDs. There are
two channels associated with a Matrix Point. These are zero based channels, meaning channel 1 is 0x00. In this
instance, b[8] is set to the input channel and b[9] is set to the output channel.



Examples:

To SET the Gain on Input Channel 4 to a value of -4.50dB, send the message 0xB32140002B01010003003EFE

To clear a Matrix Point between Input Channel 20 and USB Out, send the message 0xB321AF00A600010014200000
To SET a Matrix Point between USB In and Output Channel 2, send the message 0xB3219E00A600010021010100
To SET the compression ratio to 4.8 on Input Channel 24, send the message 0xB321F00038000300E0010000

Message Type = Parameter GET(0x22)

For Parameter Get operations the Data bytes will be in the same format as Parameter SET operations. The Parameter
values will be ignored, except in the case where a parameter is pointing to a specific channel or bank. For example, to
get the Gain value of input channel 2, send a GET message to Module ID 0x012B, Parameter Type 0x0001, with
Parameter 1 set to 0x01, Parameter 2 will be ignored. The response message will also be a Parameter GET message with
the Version Byte (b[3]) set to OxEO and will have the Parameter values set to the current state.

IMPORTANT \

In order to receive responses to Parameter GET messages, Control Center Response must be

turned on the DTX hardware. This setting is found in the Device Setting menu when
connected to an active DTX device. To turn this setting on remotely, the following V2
command can be sent: 0xB3742C010401000001 (see V2 Protocol). When programming an
external controller, it is best practice to send this message at least once to guarantee control

\ responses are enabled. /

Examples:

To GET the Mute state of Input Channel 14:

GET Message \ 0xB32210002B0102000D000000
Response 0xB32210E02B0102000D000100 | Channel is Muted

To GET the state of the Matrix Point between USB In and Output Channel 10:

(AW EIET-CM 0xB322A500A600010021090000
Response 0xB322A5E0A600010021090100 Matrix Point Active

To GET the Gain Compensation value of the Compressor on Input Channel 5:

(I IWEIET- 0xB32200002500060000000000
Response 0xB32200E025000600FDFB0O000O Gain Compensation is -10.27dB
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Message Type = Preset SET(0x13)

To recall a preset configuration on a DTX device, use the Preset SET Message Type. Set b[4] to the Zero Based Integer
that represents the desired preset, Preset 1 = 0x00, etc. All other bytes are set to 0x00. The Data bytes will be in the
following format:

b[4] b[5] b[6] b[7] b[8] b[9] b[10] b[11]
Preset 0x00 0x00 0x00 0x00 0x00 0x00 0x00

Example:

To recall the configuration stored in preset number 5, send the message 0xB313F4000400000000000000

V2 Protocol

Protocol Header
b[0] b[1] b[2] b[3] b[4]-b[131]
0xB3 Message Type Length Version Data

Message Start: 0xB3 indicates start of message.

Message Type (b[1]): Defines the type of message as follows

Value ‘ Function

0x21 Parameter SET
0x22 Parameter GET
0x13 Preset SET

0x74 Other Controls

Length (b[2]): Length specifies the length of the relevant payload. Note that different message types may count
different Bytes as payload. Be sure to read each Message Type section carefully. NOTE: Setting an incorrect Length
value can produce unexpected results.

Version: Provided for legacy purposes. This value should always be 0x01 for V2 communications.

Data: The format of the Data bytes will be determined by the Message Type value. These formats are defined below.

Message Type = Parameter SET (0x21)
For Parameter Set operations the Data bytes will be in the following format:

b[4] b[5] b[6] b[7] b[8]-b[71]
Input/Output Start Channel End Channel Parameter Type Parameter Value

Length: For Message Type 0x21, the Length (b[2]) will be the count of bytes starting with Parameter Value (b[8]).

Input/Output (b[4]): Determines whether to address an input or output channel.

Value ‘ Function

0x02 Input
0x01 Output

Start Channel (b[5]): Zero based start channel number for desired range of channels. For example, channel 1 = 0x00,
channel 2 = 0x01, etc.
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End Channel (b[6]): Zero based end channel for desired range of channels. If setting a single channel this value will be
the same as Start Channel.

Parameter Type (b[7]): Refer to Error! Reference source not found. for Parameter Type values. Use only Parameters
associated with Input Source (0x012B) when b[4] is 0x02 or Output (0x0127) when b[4] is 0x01.

Parameter Value (b[8]-b[71]): Defines parameter value to set. Each value should be represented by two bytes. Use only
the Parameter 2 values from Error! Reference source not found. since Parameter 1 (channel) values are already covered
by b[5] and b[6].

Examples:

To SET the Gain on Input Channel 1 thru 8 to a value of -6.0dB, send the message
0xB321100102000701ABFDABFDABFDABFDABFDABFDABFDABFD

Message Type = Parameter GET(0x22)

For Parameter Get operations the Data bytes will be in the same format as Parameter SET operations with the exception
that the Parameter Value bytes (9-72) will need to be set to 0x00. The response message from the device will have these
bytes filled in with the acquired parameter values. There must be enough Parameter Value place holder bytes to match
the desired response, two bytes per channel. The Length (b[2]) will be the number of channels times two bytes per
Parameter Value - or b[2] = (b[6] — b[5] + 1) * 2. The response message will also be a Parameter GET message with the
Version Byte (b[3]) set to OxE1 and will have the Parameter values set to the current state.

( IMPORTANT \

In order to receive responses to Parameter GET messages, Control Center Response must be
turned on the DTX hardware. This setting is found in the Device Setting menu when connected
to an active DTX device. To turn this setting on remotely, the following V2 command can be
sent: 0xB3742C010401000001. When programming an external controller, it is best practice
\ to send this message at least once to guarantee control responses are enabled. )

Example:

To GET the gain settings on input channels 1 to 8, send the following message

GET Message ‘ 0xB32210010200070100000000000000000000000000000000
Response ‘ 0xB32210E10200070196F632023DFDOB0203FC3202B5FB7502 | Channel 1 Gain = -24.1dB, etc

Message Type = Preset SET(0x13)
For preset SET operations the Data bytes will be in the following format:

b[4] b[5] b[6] b[7] b[8]-b[71]
Preset - - - -

Length: Length (b[2]) will always be 0x01.

Preset (b[4]): Zero based preset number (0x00 — OxOF).



Example:
To recall Preset 2, send the message 0xB313010101

Message Type = Other Controls(0x74)
Other controls include but are not limited to GPIO, RS-232, RS-485 and Central Control replies. The Control Type is
determined by b[4] and will be one of the following values:

Control Type (b[4]): Determines what function is to be controlled according to the following table:

Value Control Type

0x01 GPIO

0x02 RS-232 Send

0x03 RS-485 Send

0x04 Control Center Response
0x05 Device Info

0x06 Preset Reset

0x07 RS-485 Direction

0x08 UDP Forward

0x09 Debug Enable

Data Length (b[5]): Length of the data portion of the message (b[8]...b[n]).
Reserved (b[6] & b[7]): These bytes will always be 0x00.

e Control Type = GPIO (0x01)

b[4] b[5] b[6] b[7] b[8] b[9] b[10] b[11]
0x01 0x04 Reserved Reserved GPIO Dir Start GPIO End GPIO Value

Length: Length byte (b[2]) will always be 0x08.

GPIO Dir (b[8]): Sets input or output for the selected GPIO pins. When GPIO Dir is an Output (0x01), this
will be a SET command. When GPIO Dir is an Input (0x00) this will be a GET command.

Value Function

0x00 Input
0x01 Output
Start GPIO (b[9]): Zero based start channel number for desired range of channels. For example, channel

1 = 0x00, channel 2 = 0x01, etc.

End GPIO (b[10]): Zero based end channel for desired range of channels. If setting a single channel this
value will be the same as Start GPIO.

Value (b[11]): When ‘GPIO Dir’ (b[8]) is set to be an output, Value SETs the state of the output GPIO pin.

For GPIO inputs, this byte is used as a return field to GET the GPIO input pin state. This value byte is bit
mapped to channels 1-8 where channel 1 is the Isb and channel 8 is the msb. Bit values are as follows

Value ‘ Function
0x00 Low
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| 0x01 | High |
NOTE: Only consecutive output channels defined by b[9] & b[10] will be affected by a SET message. A
value of all zeros (0x00) or all ones (0xFF) can be sent and only the defined range will be affected.

Examples:
To set GPIO channels 1-8 to the High state, send message 0xB374080104000000010007FF

To set GPIO channels 5 & 7 to the High state, 6 & 8 to the Low state and leave all other pins alone send
the message 0xB37408010104000001040750

To GET the states of all GPIO, pins send the message 0xB37408010104000000000700
Control Type = RS-232 Send (0x02) and Control Type = RS-485 Send (0x03)

Sends a message string out of the selected serial port.

b[4] b[5] b[6] b[7] b[8]-b[131]

Control Type Message Length Reserved Reserved Message

Control Type (b[4]): Defines the desired serial port to be addressed.

Value ‘ Function

0x02 RS-232
0x03 RS-485

Message Length (b[5]): Length of the message that will be sent via the serial port.
Message (b[8]-b[131]): Message payload to be sent.
Example:

To output string "Hello, DSP." from RS232 send message
B37410010200000048656c6c6fa3ac4453502e00

Control Type = Control Center Response (0x04)

Enables or Disables DTX response to incoming UDP messages. This setting MUST be enabled to use GET
commands and can also be manually set in the Device Setting menu in the Dash software.

b[4] b[5] b[6] b[7] b[8]

0x04 0x01 Reserved Reserved Response Switch

Response Switch (b[8]): Sets the Control Center Response switch.

Value ‘ Function

0x00 OFF
0x01 ON

Example:

To enable Control Center Responses, send the message 0xB37408010400000001
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e Control Type = Device Info (0x05)

Returns the Device Name and channel counts of a DTX DSP.

b[4] b[5] b[6] b[7] b[8]- b[23] b[24] b[25] b[26] b[27]
0x05 0x14 Reserved Reserved Device Name Aln AOut DIn DOut

Length: Length byte (b[2]) will always be 0x14.

Device Name (b[8] ... b[23]): Name of the Device as set in Device Setting menu. Each byte represents an
ASCII character.

Analog Input Channels (b[24]):The number of Analog Audio Input Channels supported by this device.

Analog Output Channels (b[25]):The number of Analog Audio Output Channels supported by this
device.

Dante Input Channels (b[26]):The number of Dante Audio Input Channels supported by this device.
Dante Output Channels (b[27]):The number of Dante Audio Output Channels supported by this device.
Example:

To retrieve Device Info, send the message
0xB3741401051400000000000000000000000000000000000000000000

A valid response would be 0xB37414E1051400004454582D31363136440000000000000010101010
This equates to a device named “DTX-1616D" with 16x16 Analog and 16x16 Dante Audio Channels.

e Control Type = Preset Reset (0x06)

b[4] b[5] b[6] b[7]
0x06 0x00 Reserved Reserved

Length: Length byte (b[2]) will always be 0x04.
Example:

To reset the unit back to the current preset values and discard unsaved changes send the message
0xB374040106000000

e Control Type = RS-485 Direction (0x07)

b[4] b[5] b[6] b[7] b[8]-b[11]
0x07 0x00 Reserved Reserved Direction

Length: Length byte (b[2]) will always be 0x08.

Direction: Set the direction of the RS-485 port. 0x01 = Input, 0x00 = Output.



e Control Type = UDP (0x08)

Forwards a UDP message to a designated IP Address and Port.

b[4] b[5] b[6] b[7] b[8]-b[11] b[12]-b[13] b[14]- b[15] b[16]-b[131]
0x08 0x00 Reserved Reserved IP Address Port Data Length UDP Data

Length: Length byte (b[2]) will be set to the total length in bytes of the message starting with and
including b[4] — b[n].

IP Address: Destination IP address. Each Octet of the address gets one byte. Octet 1 is stored in b[8],
Octet 2 is stored in b[9], etc. So for an address of 192.168.1.165, b[8] is the hex representation of
integer 192 or 0xCO, b[9] is 0xAS8, b[10] is 0x01, and b[11] is OxA5.

Port: Represents the destination UDP port as a 2 byte WORD with b[12] being the LSB. Port 2323 in hex
is 0x0913, so b[12] = 0x13 and b[13] = 0x09.

Data Length: A 2-byte WORD representing the length in bytes of UDP Data. Like Port, b[14] is the LSB.

UDP Data: The message that will be forward to IP Address on Port. ASCII data must be converted to Hex.

Example:

To forward the message “HELLO, DSP!” to 192.168.0.99 on port 7000 send the message
B374180108000000c0a80063581B0c0048656c6c6f2C204453502100

e Control Type = Debug (0x09)

Enables debugging via the serial port.

b[4] b[5] b[6] b[7] b[8]-b[11]
0x07 0x00 Reserved Reserved Enable

Length: Length byte (b[2]) will always be 0x08.

Enable: When debugging is On, the system will output the runtime log to the serial port. 0x01 =
Debugging On, 0x00 = Debugging Off.
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Appendix D: Module Types
Module ID = Input Source(OxOlZB)

Parameter Type = Gam(OxOOOl)

: Channel Zero Based Integer 0-31 (equates to Chl — Ch32)
Paramete Gain Signed Integer / 100 -72.0to +12.0dB
Parameter Type = Mute(0x0002)
Paramete Channel Zero Based Integer 0-31 (equates to Ch1l — Ch32)
P ete Mute 0=0ff, 1=0n
Parameter Type = Sensitivity(0x0003)
Paramete Channel Zero Based Integer 0 to 31 (equates to Ch1l — Ch32)
Paramete Sensitivity Integer Value * 3 0 to 48dB in 3dB steps
Parameter Type = Phantom Power(0x0004)
Paramete Channel Zero Based Integer 0 to 31 (equates to Chl — Ch32)
P ete Power 0=0ff, 1=0n
Parameter Type = Signal Generator Type(0x0005)
Channel Zero Based Integer 0 to 31 (equates to Ch1l — Ch32)
Para Type 0 = Off, 1 = Sine, 2 = White, 3 = Pink
Parameter Type = Signal Generator Frequency(0x0006)
Channel Zero Based Integer 0 to 31 (equates to Ch1l — Ch32)
3 Frequency Integer Value of Hex 20 to 20000Hz
Parameter Type = Sine Wave Gain(0x0007)
Channel Zero Based Integer 0 to 31 (equates to Ch1l — Ch32)
3 Gain Signed Integer / 100 -72.0to 0.0dB
Parameter Type = Channel Name(0x0008)
3 Channel Zero Based Integer 0 to 31 (equates to Ch1l — Ch32)
P ete 0x00
Parameter Type = Phase(0x0009)
3 Channel Zero Based Integer 0 to 31 (equates to Ch1l — Ch32)
Paramete Phase Reverse 0=0ff, 1=0n
Parameter Type = Gain Nudge(0x000A)
Paramete Channel Zero Based Integer 0 to 31 (equates to Ch1l — Ch32)
Paramete Increment Size Signed Integer / 100 -3,-2,-1,+1,+2 or +3dB
Parameter Type = Link(0x000B)
Paramete Channel Integer of Lowest Channel in Link Pair 1 to 32 (Not Zero Based)
p ete Link 0=0ff, 1=0n
Parameter Type = Channel Level(0x000C)
Channel Zero Based Integer 0 to 31 (equates to Chl — Ch32)
Paramete Level Signed Integer / 100 -72.0 to +12.0dB

Module ID = System Control (0x0128)

System Gain(0x0001)
P ete 0x00
0x00
System Mute(0x0002)
< Mute 0=0ff, 1=0n
n/a 0x00
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Module ID = Output(0x0127)

Parameter Type = Galn(0x0001)

Channel Zero Based Integer 0-31 (equates to Chl — Ch32)
3 Gain Signed Integer / 100 -72.0to +12.0dB
Parameter Type = Mute(0x0002)
Channel Zero Based Integer 0-31 (equates to Chl — Ch32)
Paramete Mute 0=0ff, 1=0n

Parameter Type = Channel Name(0x0003)

Channel

Zero Based Integer

0 to 31 (equates to Ch1l — Ch32)

0x00

Parameter Type = Phase(0x0004)

Paramete Channel

Zero Based Integer

0 to 31 (equates to Ch1l — Ch32)

Paramete Phase Reverse

0=0ff,1=0n

Parameter Type = Sensitivity(0x0005)

Paramete Channel

Zero Based Integer

0 to 31 (equates to Ch1l — Ch32)

Paramete Sensitivity

Integer Value * 3

0 to 48dB in 3dB steps

Parameter Type = Gain Nudge(0x0006)

Paramete Channel Zero Based Integer 0 to 31 (equates to Ch1l — Ch32)

Paramete Increment Size Signed Integer / 100 -3,-2,-1,+1,+2 or +3dB
Parameter Type = Link(0x0007)

Paramete Channel Integer of Lowest Channel in Link Pair 1 to 32 (Not Zero Based)

p ete Link 0=0ff, 1=0n

Parameter Type = Channel Level(0x0008)

Channel

Zero Based Integer

0 to 31 (equates to Chl — Ch32)

Paramete Level

Signed Integer / 100

-72.0 to +12.0dB

Module ID = Matrix(Ox00AB6)

Parameter Type = Matrix Point(0x0001)

Paramete Channels Zero Based Integer 0-31 (equates to Ch1l — Ch32)
LSB Input Channel, MSB Output Channel Other In: 32 = AutoMix, 33 = USB, 34 = AEC,
35 = ANS
Other Out: 32 = USB
Paramete Active 0=0ff, 1=0n

Parameter Type = Matrix Point Gain(0x0002)

Paramete Channel Zero Based Integer 0-31 (equates to Chl — Ch32)
LSB Input Channel, MSB Output Channel Other In: 32 = AutoMix, 33 = USB, 34 = AEC,
35 = ANS
Other Out: 32 = USB
Paramete Gain Signed Integer / 100 -72.0to +12.0dB
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Module ID =

Input CH1 Expander (0x0001) thru Input CH32 Expander (0x0020)

Parameter Type = Enable(0x0001)

Enable 0 = Enable, 1 = Disable
n/a 0x00
Parameter Type = Threshold(0x0002)
3 Threshold Signed Integer / 100 -72.0 to 0.0dB
> ete n/a 0x00
Parameter Type = Ratio(0x0003)
Ratio Signed Integer / 100 1.00 to 20.00
Paramete n/a 0x00
Parameter Type = Attack(0x0004)
Paramete Attack Signed Integer 1 to 500ms
Paramete n/a 0x00
Parameter Type = Release(0x0005)
Paramete Release Signed Integer 1 to 10,000ms
Paramete n/a 0x00

Module ID =

Parameter Type = Enable(0x0001)

Input CH1 Compressor (0x0021) thru Input CH32 Compressor(0x0040)

Paramete Enable 0 = Enable, 1 = Disable
P n/a 0x00
Parameter Type = Threshold(0x0002)
Paramete Threshold Signed Integer / 100 -48.0 to 0.0dB
Paramete n/a 0x00
Parameter Type = Ratio(0x0003)
Paramete Ratio Signed Integer / 100 1.00 to 20.00
n/a 0x00
Parameter Type = Attack(0x0004)
3 Attack Signed Integer 1 to 500ms
n/a 0x00
Parameter Type = Release(0x0005)
3 Release Signed Integer 1 to 10,000ms
n/a 0x00
Parameter Type = Gain Compensation(0x0006)
Release Signed Integer / 100 -72.0 to +6.0dB
Paramete n/a 0x00
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Module ID = Input CH1 AutoGain (0x0041) thru Input CH32 AutoGain(0x0060)

Parameter Type = Enable(0x0001)

Enable 0 = Enable, 1 = Disable
n/a 0x00
Parameter Type = Threshold(0x0002)
Threshold Signed Integer / 100 -72.0 to -20.0dB
> ete n/a 0x00
Parameter Type = Target Level(0x0003)
Release Signed Integer / 100 -20.0 to 0.0dB
Paramete n/a 0x00
Parameter Type = Ratio(0x0004)
Paramete Ratio Signed Integer / 100 1.00 to 20.00
Paramete n/a 0x00
Parameter Type = Attack(0x0005)
Paramete Attack Signed Integer 1 to 500ms
> s n/a 0x00
Parameter Type = Release(0x0006)
Release Signed Integer 1 to 10,000ms
Paramete n/a 0x00

Module ID = Input CH1 EQ (0x0061) thru Input CH32 EQ(0x0080)

Name
Parameter Type = Enable(0x0001)

Value

Range

Parameter 1 Enable

0 = Enable, 1 = Disable

Parameter 2 VL]

0x00

Parameter Type = Band Enable(0x0002)

CEICINIS I Parametric: Band Number | Parametric: Zero Based Integer

Graphic: Q

Graphic: 1=Wide, 2=Normal, 3=Narrow

Parametric: 0-11

Parameter 2 Enable

0=0n, 1=0ff

Parameter Type = Frequency(0x0003)

Parameter 1 Band Number

Zero Based Integer

0to 30 (Bands 1 —31)

Parameter 2 Parametric: Frequency Parametric: Signed Integer

Graphic: Gain

Graphic: Signed Integer / 100

Parametric: 20 to 20,000Hz
Graphic: -24.0 to +12.0dB

Parameter Type = Gain(0x0004)

Parameter 1 Band Number

Zero Based Integer

0to 30 (Bands 1—-31)

Parameter 2 Gain

Signed Integer / 100

-24.0 to +18.0dB

Parameter Type = Q Value(0x0005)

Parameter 1 Band Number

Zero Based Integer

0to 30 (Bands 1 —-31)

Parameter 2 Q Value

Signed Integer / 100

0.02 to 50.0

Parameter Type = Type(0x0006)

EE R\ [Ma]oIsl@ Band Number

Zero Based Integer

0to 30 (Bands 1 —31)

Parameter 2 Y3

O=Low Pass, 1=High Pass, 2=reserved ,
3=reserved, 4=reserved , 5=reserved,
6=Parametric , 7=Low Shelf , 8=High Shelf

66



Module ID = Input CH1 Feedback Suppression (0x0081) thru Input CH32 Feedback Suppression (0x00A0)

Parameter Type = Enable(0x0001)
3 Enable 0 = Enable, 1 = Disable
n/a 0x00
Parameter Type = Feedback Point Frequency(0x0002)
3 Feedback Storage Slot | Zero Based Integer Oto7
Paramete Frequency Signed Integer 20 to 20,000Hz
Parameter Type = Feedback Point Gain(0x0003)
3 Feedback Storage Slot | Zero Based Integer Oto7
Paramete Gain Signed Integer / 100 -24.0 t0 0.0dB
Parameter Type = Octave(0x0004)
Paramete Octave 0x000A = 1/10th, 0x0014 = 1/5th
Paramete n/a 0x00
Parameter Type = Type(0x0005)
Paramete Feedback Storage Slot | Zero Based Integer Oto7
Paramete Type 0 = Dynamic, 1 = Manual
Parameter Type = Step(0x0006)
ara Release Signed Integer / 100 0.5t0 3.0
Paramete n/a 0x00
Parameter Type = Reserved(0x0007)
Paramete n/a 0x00
Paramete n/a 0x00
Parameter Type = Panic Limit Threshold(0x0008)
Paramete Threshold Signed Integer / 100 -36.0 to 0.0dB
P ete n/a 0x00
Parameter Type = Filter Depth(0x0009)
ara Depth Signed Integer / 100 1.0 to 24.0
Paramete n/a 0x00
Parameter Type = Feedback Threshold(0x000A)
Paramete Threshold Signed Integer / 100 -96.0 to-24.0dB
Paramete n/a 0x00

Module ID = Echo Cancellation (0Ox00A3)

Parameter Type = Enable(0x0001)
3 Enable 0 = Enable, 1 = Disable
Paramete n/a 0x00
Parameter Type = Non-Linear Processor(0x0002)
Paramete NLP 0 = Conservative, 1 = Moderate, 2 = Aggressive
Paramete n/a 0x00

Module ID = Echo Cancellation Source (0x00A2)

Parameter Type = Source(0x0001)
CETETNE G Channel Local: Zero Based Integer, 0x0020 = AutoMixer;
Remote: 0x0100 && Zero Based Channel), 0x0121 = USB
Parameter 2 [ 0 =0ff,1=0n




Module ID = AutoMix (0x00A1)

Parameter Type = Total Mute(0x0001)

Mute 0=0ff, 1=0n
n/a 0x00
Parameter Type = Total Gain(0x0002)
e Gain Signed Integer / 100 -72.0to +12.0dB
> ete n/a 0x00
Parameter Type = Slope0x0003)
Slope Signed Integer / 100 1.0to0 3.0
> ete n/a 0x00
Parameter Type = Response Time(0x0004)
Paramete Response Signed Integer 1to 5,000ms
> n/a 0x00

Parameter Type = Channel AutoMix Enable(0x0005)

Paramete Channel

Zero Based Integer

0 to 31 (equates to Ch1l — Ch32)

Paramete Activate

0=0ff,1=0n

Parameter Type = Channel AutoMix Mute(0x0006)

Channel

Zero Based Integer

0 to 31 (equates to Chl — Ch32)

P ete Mute

0=0ff, 1=0n

Parameter Type = Channel autoMix Gain(0x0007)

Paramete Channel Zero Based Integer 0 to 31 (equates to Chl — Ch32)
Paramete Gain Signed Integer / 100 -72.0 to +12.0dB
Parameter Type = Priority(0x0008)
Paramete Channel Zero Based Integer 0 to 31 (equates to Chl — Ch32)
P ete Priotiry Signed Integer 1to 10
Parameter Type = Enable(0x0009)
Enable 0 = Enable, 1 = Disable
Paramete n/a 0x00

Module ID = Noise Suppression(OxOOAS)

Parameter Type = Enable(0x0001)

Enable 0 = Enable, 1 = Disable
n/a 0x00
Parameter Type = Level(0x0002)
3 e Level 0=6dB, 1=10dB, 2 = 15dB, 3 =18dB
Paramete n/a 0x00

Module ID = Noise Suppression Source (0x00A4)

Parameter Type = Source(0x0001)

Parameter 1

0x0022 = AEC

Channel Local: Zero Based Integer, 0x0020 = AutoMixer, 0x0021 = USB,

Parameter 2 [ 0 =0ff,1=0n
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Module ID = Output CH1 Filter (OX00A7) thru Output CH32 Filter (0x00C6)

Parameter Type = High Pass Enable(0x0001)

Parameter 1 Enable

0 = Enable, 1 = Disable

Parameter 2 YE

0x00

Parameter Type = High Pass Type(0x0002)

Parameter 1 R

0 = Bessel, 1 = Butterworth, 2 = Linkwitz Reily

Parameter 2 YE

0x00

Parameter Type = High Pass Slope(0x0003)

Parameter 1 ]3]

Signed Integer

6,12, 18, 24, 32, 36, 42, 48dB/Octave

Parameter 2 [YE

0x00

Parameter Type = High Pass Frequency(0x0004)

Parameter 1 Frequency

Signed Integer

20 to 20,000Hz

Parameter 2 YE

0x00

Parameter Type = High Pass Gain(0x0005)

Parameter 1 Gain

Signed Integer / 100

-15.0 to +15.0dB

Parameter 2 [YE

0x00

Parameter Type = Low Pass Enable(0x0006)

Parameter 1 Enable

0 = Enable, 1 = Disable

Parameter 2 [VE]

0x00

Parameter Type = Low Pass Type(0x0007)

Parameter 1 RS

0 = Bessel, 1 = Butterworth, 2 = Linkwitz Reily

Parameter 2 E]

0x00

Parameter Type = Low Pass Slope(0x0008)

GEICTNCICT I Slope

Signed Integer

6,12, 18, 24, 32, 36, 42, 48dB/Octave

Parameter 2 E] 0x00

Parameter Type = Low Pass Frequency(0x0009)
Parameter 1 Frequency Signed Integer 20 to 20,000Hz
Parameter 2 VL] 0x00

Parameter Type = Low Pass Gain(0x000A)

Parameter 1 Gain

Signed Integer / 100

-15.0 to +15.0dB

0x00

Parameter 2 VL]

Module ID = Output CH1 Delay (0x00E7) thru Output CH32 Delay(0x0106)

Name
Parameter Type = Enable(0x0001)

Value

Range

Parameter 1 Enable

0 = Enable, 1 = Disable

Parameter 2 YE

0x00

Parameter Type = Milliseconds(0x0002)

Parameter 1

Parameter 2 YE

Parameter 1

Milliseconds Signed Integer (add to Microseconds) 0 to 1200ms
0x00
Parameter Type = Microseconds(0x0003)
Microseconds Signed Integer / 100 (add to Milliseconds) 0 to 999us

Parameter 2 YE

0x00
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Module ID = Output CH1 EQ (0x00C7) thru Output CH32 EQ(Ox0O0E6)

Name
Parameter Type = Enable(0x0001)

Value

Range

Parameter 1 Enable

0 = Enable, 1 = Disable

Parameter 2 YE

0x00

Parameter Type = Band Enable(0x0002)

Parameter 1 Parametric: Band Number
Graphic: Q

Parametric: Zero Based Integer
Graphic: 1=Wide, 2=Normal, 3=Narrow

Parametric: 0-11

Parameter 2 Enable

0=0n, 1=0ff

Parameter Type = Frequency(0x0003)

Parameter 1 Band Number

Zero Based Integer

0to 30 (Bands 1 —-31)

Parameter 2 Parametric: Frequency
Graphic: Gain

Parametric: Signed Integer
Graphic: Signed Integer / 100

Parametric: 20 to 20,000Hz
Graphic: -24.0 to +12.0dB

Parameter Type = Gain(0x0004)

Parameter 1 Band Number

Zero Based Integer

0to 30 (Bands 1 —31)

Parameter 2 Gain

Signed Integer / 100

-24.0 to +18.0dB

Parameter Type = Q Value(0x0005)

Parameter 1 Band Number

Zero Based Integer

0to 30 (Bands 1 —31)

Parameter 2 Q Value

Signed Integer / 100

0.02 to 50.0

Parameter Type = Type(0x0006)

EER R\ Mgl I8 Band Number

Zero Based Integer

0to 30 (Bands 1 —31)

Parameter 2 N3

O=Low Pass , 1=High Pass, 2=reserved ,
3=reserved, 4=reserved , 5=reserved,
6=Parametric, 7=Low Shelf , 8=High Shelf

Module ID = Output CH1 Limiter (0x0107) thru Output CH32 Limiter (0x0126)

Name
Parameter Type = Enable(0x0001)

Value

Range

Parameter 1 Enable

0 = Enable, 1 = Disable

Parameter 2 [VE] 0x00

Parameter Type = Threshold(0x0002)

Parameter 1 Threshold

Signed Integer / 100

-72.0 to 0.0dB

Parameter 2 E] 0x00

Parameter Type = Release(0x0005)

Parameter 1 Release

Signed Integer

1 to 10,000ms

Parameter 2 £ 0x00

70



Appendix E: User Interface Creation
Aurora’s Dash software includes facility to create a custom User Interface to control DTX DSP devices. This custom Ul can

be run locally on a PC or on any iOS or Android device using a free app.

Quick Start

e Install iOS or Android app on device

e Select a Template

e Drag Objects from the Object Bar to the Page

e Set the IP address and parameters of each Object
e Style Page and Objects to taste

e Syncto device
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Running the Custom User Interface
The Dash Custom User Interface can be viewed on any one of three supported platforms. For a Windows PC with Dash

installed, the Ul can be run directly by just double clicking the design file. On iOS and Android phones and tablets the
design can be run using a downloaded app.

PC

A saved project file is a fully encapsulated file which can just be run on a PC which already has Dash installed. Double
clicking on the saved file will open it as an encapsulated app running the custom User Interface. See the description of
the File Menu for instructions on saving a project. Below is a screen capture of an encapsulated file with a description of
the features.

Page Tabs: Navigation between pages in a Custom Ul. Click on the page name to activate.

Enable Chanel Alarm: Meter Objects can be set to trigger an alarm if the signal level exceeds or drops below set levels.
The control will flash red, and an audible alarm will sound. This check box will defeat this feature when unchecked.

Open Log Directory: Opens directory where the log files are stored.

Enable Audio Alarm: If Enable Channel Alarm is checked, this checkbox determines if the audible alarm is sounded in
response to a level trigger. If this check box is unchecked, a level trigger will still flash the control red, but no sound will
be heard.
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View Added Devices: This functionality is not active.

Device List: This is like the Device List in Dash. It shows details about devices that are in active communication with the
Custom UlI.

i0S
To install the DSP Pro app on an iOS phone or tablet, simply go to the Apple Store and search for “DSP Pro” and
install the app. See Sync’ing to a Device for instructions on how to push your design to the app.

Android

The Android version of DSP Pro is not available on the Google Play store at this time. The .apk (app) file can be
obtained directly from Aurora and installed manually on an Android device. Contact your Aurora representative to
obtain the file. Download the apk file to your device by either direct URL link, cloud drive, email, etc. Click on the file to
install the app. See Sync’ing to a Device for instructions on how to push your design to the app.

Workspace

The Workspace is comprised of several areas that will be discussed in detail in this manual. The Tool Bar and Object Bar
will the primary elements that will be used in creating your designs. The Property Window is context sensitive and will
change depending on what object is currently selected. Below the Object Bar are the Page Tabs. The Dash Custom User
Interface supports multiple pages to allow for complex and organized designs. Simply clicking on the Page name will
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change the view to that page. The active page name will be highlighted. To change the Page name, double click on the
name and type the new one. Clicking out of the Page name will save the new name.

Right Click Menus

Right clicking anywhere in the Active Project area will
bring up one of two standard menus. Right clicking on
the background brings up a small context menu.

Select All: Selects all objects in the active page.
Paste: Pastes copied objects from the clipboard.
Clear All: Clears all objects on the active page.
Property: Opens the Properties Window if closed.

Right clicking on any other object selects the object and
opens the second context menu.

Copy: Copies the selected object to the clipboard.
Delete: Deletes the selected object.

Send to Back: Moves the selected object to the back
layer.

Bring Forward: Moves the selected object forward one layer.
Send to Bottom: Moves the selected object backward one layer.
Bring Top: Moves the selected object to the top layer.

Group: Groups the selected objects together.

Ungroup: Ungroups previously grouped objects. This command will also ungroup a Routing Object into individual Check
Buttons.

Property: Opens the Properties Window if closed.



Menu Bar

File

Open: Opens a saved project from local storage. If an active project is currently loaded, a dialog box will appear asking if
you wish to overwrite the current page. If you answer ‘Yes’, the existing project will be cleared an the new one opened.
If you answer ‘No’, the new project will be added as a new page to the existing project.

Save: Saves current project to local storage. The saved file is not only a snapshot of the project, but it can also be run as
a standalone Dash user interface. This file can be double clicked on any PC that has the Dash software installed.

Settings
Resolution: Opens the Template selector

Help
About: Opens About Dialog

Tool Bar

New Page: Multiple control pages are supported in the Dash Ul Creator. This button adds a new page.

Save: Saves current project to local storage. The saved file is not only a snapshot of the project, but it can also be run as
a standalone Dash user interface. This file can be double clicked on any PC that has the Dash software installed.

Open: Opens a saved project from local storage. If an active project is currently loaded, a dialog box will appear asking if
you wish to overwrite the current page. If you answer ‘Yes’, the existing project will be cleared an the new one opened.
If you answer ‘No’, the new project will be added as a new page to the existing project.

Template: Opens the Template selection Dialog. See Templates for more information.
Sync: Opens the Sync dialog. See Sync’ing to a Device for more information.
Rotate: Rotates the layout between Portrait and Landscape.

Global IP Replace: Opens a tool to quickly find and replace IP addresses in the
design. Enter the IP address which you wish to FIND in the Source IP Address field
and the address you will use to replace in the Destination IP Address field. The
Range combo box allows you to limit the replacement range to a specific page or
all pages.

Undo / Redo: Perform an Undo operation on the previous edit or Redo to reverse and Undo operation.
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Align Objects: Use the mouse to draw a rectangle around multiple objects or hold down the Ctrl key while selecting
multiple objects. Click the Left, Top, Right or Bottom buttons to align the selected objects accordingly.

Object Spacing: Use the mouse to draw a rectangle around multiple objects or hold down the Ctrl key while selecting
multiple objects. Use the “Equidistance in Horizontal Direction” or “Equidistance in Horizontal Direction” to equally
space all selected objects equally between the outer two objects or “Custom Distance in Horizontal Direction” or
“Custom Distance in Horizontal Direction” for more precise spacing.

Object Bar

The Object Bar allows for the selection of various objects into the current Page
workspace. With your mouse, simply click and hold the Object icon from Object Menu
and drag it to the desired location on the Page. When the mouse button is released, the
object will be created. The object can them be dragged and/or sized to the proper
position on the page. See section impler and more accurate method is to use the ‘Device

QUICK TIP
Click and Hold to drag
objects from the Object
Bar to the Page.

Template’ tab of the Template Dialog.

To automatically create the perfect template for your device, first have the target device connected to the same
network as the Dash Software and run the DSP Plus app (see
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Running the Custom User Interface for information about installing the apps). Now, select the ‘Device Template’ tab or
click the ‘Refresh’ icon at the top left corner of the tab. The list will populate with all devices on the network that are
running the DSP Plus app. Simply select the desired target device and click ‘Apply’. The software will poll the device and
create a perfectly compatible Template and add it to the Template list for future use.

Manual Template Creation
If you already know the precise resolution and density of the device, you can manually enter those values and create a

Template. From the Local Template tab, click the blue ‘Plus’ icon at the top left of the dialog box.
Name: Enter a user-friendly name to easily identify the Template.

Idiom: Select Phone, Pad or PC from the list.

Platform: Identifies the OS platform of the target device.

Resolution: The screen resolution of the target device.

Density: TBD

Objects for detailed information on each Object type.

The Zoom combo box allows for the adjustment of the zoom level of the active project.

Templates
Templates are used to set the usable area of the target device. The

Template selection dialog is available from the Menu Bar by selecting

Settings | Resolution or by clicking the Template icon from the
Tool Bar. Either method will bring up the Template Dialog. Simply
select one of the preset Templates from the list and click ‘Apply’. If
the project is blank, it will create a new project page. If this is done
while a project is open, it will change the project Template to the
newly selected Template. NOTE: This may make already placed
objects out of the page boundaries, these objects will have to be
adjusted. After a Template is selected, the orientation of the page
can be altered using the Rotate button from the Tool Bar.

The Template list can be maintained by using the Delete button to remove a Template from the list or Edit to change the

parameters of the selected Template. See Manual Template Creation for more information about the Edit Template
dialog.
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Automatic Template Creation

If the desired Template is not displayed in the preset list, it can be
either manually entered by clicking the blue ‘Plus’ icon at the top left
of the dialog, or a much simpler and more accurate method is to use
the ‘Device Template’ tab of the Template Dialog.

To automatically create the perfect template for your device, first
have the target device connected to the same network as the Dash
Software and run the DSP Plus app (see
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Running the Custom User Interface for information about installing the apps). Now, select the ‘Device Template’ tab or
click the ‘Refresh’ icon at the top left corner of the tab. The list will populate with all devices on the network that are
running the DSP Plus app. Simply select the desired target device and click ‘Apply’. The software will poll the device and
create a perfectly compatible Template and add it to the Template list for future use.

Manual Template Creation

If you already know the precise resolution and density of the device, you can manually enter
those values and create a Template. From the Local Template tab, click the blue ‘Plus’ icon at
the top left of the dialog box.

Name: Enter a user-friendly name to easily identify the Template.
Idiom: Select Phone, Pad or PC from the list.

Platform: Identifies the OS platform of the target device.
Resolution: The screen resolution of the target device.

Density: TBD

Objects
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Page

The Page object is the background of the application upon which device Objects are
placed. There can be multiple pages in a single project. Pages are added using the
‘New Page’ button on the Tool Bar and can be navigated using the Page Tabs just
below the Object Bar.

Page Name: Double click on the page name in the Page Tab to rename the page.

Background: Select this radio button to use a solid color background. Colors can be
selected by sliding the color target around in the palate. The palate can be changed
by adjusting the hue slider. Alternately, numeric RGB values can be entered to get a
precise color. The ‘A’ adjustment changes the transparency from fully transparent to
fully opaque.

Image: Select this radio button to use an image background for the page.
File Path: Selects a local file to use as an image background for the page.

Fill Mode: Determines the fill method used to apply the image to the background. Select one of the following:

e Normal — The image is used unaltered. Edges may be cropped, or background may not be fully covered
depending on the resolution of the image.

e  Fill - Stretches the image to fill the background. The background will be completely covered, the full image is
used but may be distorted.

e Uniform — Zooms the image to fill the background. The background may have uncovered space on the top and
bottom or left and right, the full image is used, and it will not be distorted.

e Uniform to Fill - Zooms the image to fill the entire background. The background will be completely covered, the
image may have some edges cropped, but will not be distorted.

Apply to Global Background: Clicking this button applies the current page background to all pages.

Using a Global Background: This checkbox indicates that a Global Background is being used for the current page.
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Label
Label is a customizable text object used for adding clarity or instruction to your

design.

Text: This is the text that will be displayed.

Width: The width of the bounding box in pixels. This does not affect font size.
Height: The height of the bounding box in pixels. This does not affect font size.
Font: The font used to display the text. Select from the drop-down list.

Font Size: Select the desired font size from the drop-down list. Bold and/or Italic can
be applied using the two round buttons next to the Font Size.

Corner Radius: Set the corner radius of the bounding box in pixels.

Horizontal Alignment: Sets Left, Centered or Right justification for the text in
relation to the bounding box.

Vertical Alignment: Set the Top, Center or Bottom justification for the text in relation to the bounding box.

Border Thickness: Sets the line thickness of the bounding box in pixels. Setting this to a value of 0 will make the
bounding box invisible.

Border Brush: Sets the color of the bounding box. With this selected, use the color selector at the bottom of the
Properties Window to select the desired color. Setting the ‘A’ value (transparency) to 0 will also make the bounding box
invisible regardless of the Border Thickness.

Foreground: Sets the text color and transparency. With this selected, use the color selector at the bottom of the
Properties Window to select the desired color.

Background: Sets the background color and transparency of the bounding box. With this selected, use the color selector
at the bottom of the Properties Window to select the desired color.
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Channel

The Channel object is a bundled object which includes a Gain Slider, a Level Meter,
Channel Name, Gain Text Value and Mute in a single customizable object. The
Channel object can be configured as either an input or output channel. When the
Custom User Interface app is connected to a live DTX device, Channel Name, Gain
and Mute values will be replaced with the live values on the device.

Width: Adjusts the width of the Channel object. Note that only the bounding box,
Mute button and Gain Test Value scale in this direction.

Height: Adjusts the height of the Channel object. Note that only the bounding box,
Gain Slider and Level Meter scale in this direction.

Corner Radius: Set the corner radius of the bounding box in pixels.

Device IP: Sets the IP address of the DTX device that this object will control. Note that a single Custom User Interface can
control multiple DTX devices.

Channel Type: Determines whether the Channel object will control an input or output channel.
Index Chanel: Select the channel number that this Channel object will control.

Foreground: Sets the text color and transparency of the Channel Name and Gain Scale. With this selected, use the color
selector at the bottom of the Properties Window to select the desired color.

Background: Sets the background color and transparency of the bounding box. With this selected, use the color selector
at the bottom of the Properties Window to select the desired color.

Preset

Creates a Preset selection drop-down box. The presets which are made visible can be
customized. When the Custom User Interface app is connected to a live DTX device,
the preset names assigned on the device will replace the generic (preset 1, ...) seen in
this creation tool.

Width: Sets the width of the object.
Preset: Preset numbers which are checked will appear in the drop-down list.

Device IP: Sets the IP address of the DTX device that this object will control. Note that a single Custom User Interface can
control multiple DTX devices.

82



Image
The Image object allows logos, or any other standard image file to be displayed in
the User Interface.

File Path: Selects a local file to use as an image to be placed on the page.
Width: Sets the desired width of the image in pixels.
Height: Sets the desired height of the image in pixels.

Constrain Proportions: If this is checked, the aspect ratio of the image will be maintained. Note that with this checked,
changing the width or height values will automatically change the other to maintain proper proportions.

Button

The Button object can trigger single, stateless commands. It is not tied to any
specific DTX command and can be fully customized. There are two tabs in the Button
Property Window, Text and Command. These are described below.

TEXT TAB

Text: This is the text that will be displayed on the face of the Button.

Width: The width of the Button in pixels. This does not affect font size.
Height: The height of the Button in pixels. This does not affect font size.
Corner Radius: Set the corner radius of the Button in pixels.

Font: The font used to display the Button text. Select from the drop-down list.

Font Size: Select the desired font size from the drop-down list. Bold and/or Italic can
be applied using the two round buttons next to the Font Size.

Border Thickness: Sets the line thickness of the Button’s border in pixels. Setting this to a value of 0 will make the border
invisible.

Foreground: Sets the text color and transparency. With this selected, use the color selector at the bottom of the
Properties Window to select the desired color.

Background: Sets the background color and transparency of the Button. With this selected, use the color selector at the
bottom of the Properties Window to select the desired color.

Border Brush: Sets the color of the Button’s border. With this selected, use the color selector at the bottom of the
Properties Window to select the desired color. Setting the ‘A’ value (transparency) to 0 will also make the border
invisible regardless of the Border Thickness.
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COMMAND TAB

While the Button object is not tied to any specific DTX command, it is highly flexible
in that it can be programmed to send a single or multiple UDP or serial commands.
To add a command to the Button, simply click the blue ‘Plus’ icon at the bottom right
of the Command Tab of the Button Properties Window. Repeat to add additional
commands.

Type: Selects the type of command to be sent when pressed. Choose from UDP,
RS232 or RS485.

Coding: Defines the format of the data payload. Select Hexadecimal for HEX
commands or ASCII for text-based commands.

Command: Enter the command to be transmitted upon button press.
IP Address: If Type is set to UDP, this sets the destination IP address.

Port: If Type is set to UDP, this is sets the UPD port to communicate with on the destination device.

Check Button

Unlike the previous Button object, the Check Button object is a two-state button. It
also supports a host of built in DTX commands as well as the ability to use it for
custom commands. Like the Button object, the Check Button Properties Window has
two tabs, Text and Command described below.

TEXT TAB

Text: This is the text that will be displayed on the face of the Check Button.

Width: The width of the Check Button in pixels. This does not affect font size.
Height: The height of the Check Button in pixels. This does not affect font size.
Corner Radius: Set the corner radius of the Check Button in pixels.

Font: The font used to display the Check Button text. Select from the drop-down list.

Font Size: Select the desired font size from the drop-down list. Bold and/or Italic can
be applied using the two round buttons next to the Font Size.

Border Thickness: Sets the line thickness of the Check Button’s border in pixels. Setting this to a value of 0 will make the
border invisible.

Background: Sets the background color and transparency of the Check Button in the unchecked state. With this
selected, use the color selector at the bottom of the Properties Window to select the desired color.
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Checked Background: Sets the background color and transparency of the Check Button in the checked state. With this
selected, use the color selector at the bottom of the Properties Window to select the desired color.

Checked Foreground: Sets the text color and transparency in the checked state. With this selected, use the color
selector at the bottom of the Properties Window to select the desired color.

Foreground: Sets the text color and transparency in the unchecked state. With this selected, use the color selector at
the bottom of the Properties Window to select the desired color.

Border Brush: Sets the color of the Check Button’s border. With this selected, use the color selector at the bottom of the
Properties Window to select the desired color. Setting the ‘A’ value (transparency) to 0 will also make the border
invisible regardless of the Border Thickness.

COMMAND TAB

While the Check Button can issue one of several DTX commands. In addition, it can
be programmed to send a single or multiple UDP or serial commands. For DTX
commands, select ‘System Command’ and complete the properties. The available
properties will change depending on the Control Zone selection. To add a custom
command to the Button, simply click the blue ‘Plus’ icon at the bottom right of the
Command Tab of the Button Properties Window. Repeat to add additional
commands.

System Command: Select this radio button to use the Check Button for one of
several built in DTX commands.

Control Zone: Selects which type of DTX command will be sent. Select from Inputs,
Outputs, System or Matrix. When Matrix is selected, the matrix point is determined
by the Input Channel and Output Channel values.

Input Channel: When Control Zone is set to Inputs or Matrix, selects the Input
Channel to be addressed.

Output Channel: When Control Zone is set to Outputs or Matrix, selects the Output Channel to be addressed.

Control Type: Sets the control parameter that will be set. When Control Zone is set to Inputs, values are Mute, Phantom
and Phase. When Outputs is selected, the values are Mute and Phase. When System is selected only Mute is available
which will control the system wide mute. This property is not available when Matrix is the Control Zone value.

Device IP: Sets the IP address of the DTX device that this object will control. Note that a single Custom User Interface can
control multiple DTX devices.

Custom Command: When this radio button is selected, one or more custom commands will be sent instead of a built-in
DTX command.

85



Checked/Unchecked Tabs: Each state of the Check Button can have separate custom commands. When Checked is
highlighted the command list will be executed when the Check Button changes to the checked or depressed state. When
Unchecked is highlighted the command list will be executed when the Check Button changes to the unchecked or raised
state.

Type: Selects the type of command to be sent when the state is changed. Choose from UDP, RS232 or RS485.

Coding: Defines the format of the data payload. Select Hexadecimal for HEX commands or ASCII for text-based
commands.

Command: Enter the command to be transmitted upon state change.
IP Address: If Type is set to UDP, this sets the destination IP address.
Port: If Type is set to UDP, this is sets the UPD port to communicate with on the destination device.

Route

The Route object controls the DTX matrix. This control is a preset grouping of Check Buttons
and have the same set of visual customizations available. When the control is first dragged
into a project, a dialog box will appear prompting the user for the input and output channel
count and IP address of the DTX device.

Matrix: Sets the number of Input and Output channels to display. Available values are 4, 8,

12, 16 & 32. The first selection determines the number of inputs and the second determines the number of outputs. The
channels will always start at channel one and will be consecutive. The result will be an array of Check Buttons with
Inputs as columns and Outputs as rows.

Device IP: Sets the IP address of the DTX device that this object will control. Note that a single Custom User Interface can
control multiple DTX devices.

Text: This is the text that will be displayed on the face of every Check Button in the
Route Object. NOTE: By default text on the Check Buttons in the Route Object will be
in the format ‘IN[Ch number]->Out[Ch number]’. Changing this field will change all
Check Buttons to the same text. If it desired to have a custom label on each Check
Button face, right click on the object and select ‘Ungroup’. Now each button will
have its own set of properties.

Width: The width of each individual Check Button in pixels. This does not affect font
size.

Height: The height of each individual Check Button in pixels. This does not affect font
size.

Corner Radius: Set the corner radius of each individual Check Button in pixels.

Font: The font used to display the Check Button text. Select from the drop-down list.

86



Font Size: Select the desired font size from the drop-down list. Bold and/or Italic can be applied using the two round
buttons next to the Font Size.

Border Thickness: Sets the line thickness of each individual Check Button’s border in pixels. Setting this to a value of 0
will make the border invisible.

Background: Sets the background color and transparency of each individual Check Button in the unchecked state. With
this selected, use the color selector at the bottom of the Properties Window to select the desired color.

Checked Background: Sets the background color and transparency of each individual Check Button in the checked state.
With this selected, use the color selector at the bottom of the Properties Window to select the desired color.

Checked Foreground: Sets the text color and transparency in the checked state. With this selected, use the color
selector at the bottom of the Properties Window to select the desired color.

Foreground: Sets the text color and transparency in the unchecked state. With this selected, use the color selector at
the bottom of the Properties Window to select the desired color.

Border Brush: Sets the color of each individual Check Button’s border. With this selected, use the color selector at the
bottom of the Properties Window to select the desired color. Setting the ‘A’ value (transparency) to 0 will also make the
border invisible regardless of the Border Thickness.

Level Meter

The Level Meter object displays real time metering data for either an input or output
channel. The object includes an alarming feature which monitors a loss of signal
and/or peak level.

Width: The width of the Level Meter in pixels. This does not affect font size.
Height: The height of the Level Meter in pixels. This does not affect font size.
Corner Radius: Set the corner radius of the Level Meter in pixels.

Level Mark: Selects which side of the Meter the level markings should be displayed.
Choose either left, right or no markings.

Device IP: Sets the IP address of the DTX device that this object will control. Note
that a single Custom User Interface can control multiple DTX devices.

Channel Type: Determines whether the Level Meter object will display an input or
output channel.

Index Chanel: Select the channel number that this Level Meter object will display.

Alarm: Determines what if any levels will trigger an alarm in the Custom User Interface. When an alarm is triggered, the
Level Meter object will flash red and an audible sound will be heard on the host device. There are two options for

triggering an alarm. Check the first box to create a loss of signal alarm which will trigger when the signal drops below the
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level indicated in the input box. Check the second box to create a peak level alarm which will trigger when the signal
goes above the level indicated in the input box. Both the loss of signal and peak level thresholds can be manually set.

Foreground: Sets the text color and transparency of the Level Scale. With this selected, use the color selector at the
bottom of the Properties Window to select the desired color.

Background: Sets the background color and transparency of the bounding box. With this selected, use the color selector
at the bottom of the Properties Window to select the desired color.

Gain Slider

The Gain Slider object adjusts either an input or output channel gain. It has the same
functionality as the Channel object without the Meter, Channel Name, Mute or Gain
Text.

Width: Adjusts the width of the Gain Slider object.
Height: Adjusts the height of the Gain Slider object
Corner Radius: Set the corner radius of the bounding box in pixels.

Device IP: Sets the IP address of the DTX device that this object will control. Note
that a single Custom User Interface can control multiple DTX devices.

Channel Type: Determines whether the Gain Slider object will control an input or
output channel.

Index Chanel: Select the channel number that this Gain Slider object will control.

Foreground: Sets the text color and transparency of the Gain Scale. With this selected, use the color selector at the
bottom of the Properties Window to select the desired color.

Background: Sets the background color and transparency of the bounding box. With this selected, use the color selector
at the bottom of the Properties Window to select the desired color.

Gain Text
The Gain Text object controls the gain of either an input or output channel. Gain is

set by simply typing in the gain value.
Width: Adjusts the width of the Gain Text object.
Height: Adjusts the height of the Gain Text object

Device IP: Sets the IP address of the DTX device that this object will control. Note
that a single Custom User Interface can control multiple DTX devices.

Channel Type: Determines whether the Gain Text object will control an input or
output channel.
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Index Chanel: Select the channel number that this Gain Text object will control.

Foreground: Sets the text color and transparency. With this selected, use the color selector at the bottom of the
Properties Window to select the desired color.

Background: Sets the background color and transparency of the bounding box. With this selected, use the color selector
at the bottom of the Properties Window to select the desired color.

Border
The Border object is a passive object used to visually group objects on the page.

Width: Adjusts the width of the Border object.
Height: Adjusts the height of the Border object
Corner Radius: Set the corner radius of the Border in pixels.

Border Thickness: Sets the line thickness of the Border in pixels. Setting this to a
value of 0 will make the border invisible.

Border Brush: Sets the color of the Border. With this selected, use the color selector
at the bottom of the Properties Window to select the desired color. Setting the ‘A’
value (transparency) to 0 will also make the border invisible regardless of the Border
Thickness.

Background: Sets the background color and transparency of the Border. With this selected, use the color selector at the
bottom of the Properties Window to select the desired color.

Sync’ing to a Device
When your design project is complete, it can be pushed out to an iOS or Android device. This can be accomplished very
easily be following a few simple steps.

1) Verify that the target device(s) (phone or tablet) is on the same network as the computer running Dash and that
the DSP Pro app is running. For information about installing the DSP Pro app, see Running the Custom User
Interface.

2) Click the Syncicon L" from the Tool Bar.

3) The sync dialog will open and begin scanning for target devices. All compatible devices on the network will
appear in the list.

4) Select the target device(s) to which you wish to push the project by checking the box(es) in the far-left column
or click ‘Select All’.

5) Click the ‘Sync’ Button.
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Appendix F: Serial Port to UDP Conversion

DTX DSPs support RS-232 to UDP translation. When a DTX device receives a serial message where the first four bytes are
‘UDP:’ the message will be translated and sent via the LAN port. The protocol for this function is as follows:

b[0]-b[3] (prefix) b[4]-b[7] b[8]-b[9] b[10] B[11] <128bytes
0x3a504455 IP Address Port Data Length Reserved Data

Prefix (b[0]-b[3]): Four byte prefix that identifies the message as a serial to UDP translation message. Should always be
ASCII ‘UDP:’ or the hex equivalent 0x3A504455.

IP Address (b[4]-b[7]): Destination IP address for the UDP message.

Port (b[8]-b[9]): UDP port on destination device.

Data Length (b[10]): Length of the Data portion of the message, not including prefix, address and port.
Data: Message payload. Maximum 128 bytes.

For example, when sending a “HELLO DSP” message to a device at 192.168.1.22 port 50000, the protocol would look as
follows:

b[0]-b[3] (prefix) b[4]-b[7] b[8]-b[9] b[10] B[11] <128bytes
0x3a504455 0x1610A8C0  OxC350 0x09 0x00 0x505344204F4C4C4548

Use Case

When using an external controller which does not have a network port or network access, a DTX device can be used to
communicate via UDP over the network. The Controller Host is connected to the serial port of a DTX device, and that
device performs the translation into UPD and broadcasts to the network. Other DTX devices or any third-party devices
on the network can be controlled via the Controller Host serial port.

RS232

90



Appendix G: Specifications

DTX-44D DTX-88D DTX-1616D DTX-3232D DTX-6464D
Analog I/O Channels 4x4 8x8 16x16 - -
Dante /O Channels 4x4 | 8x8 | 16x16 32x32 64x64
Input
Analog Input Gain 0/6/12/18/24/30/36/42/48 dB
Input Impedance 5.4KQ
Frequency Response (20 Hz to 20 kHz)+0.5dB
THD+N <-94dB @17dBu
Maximum level +18dbu n/a n/a
Input Dynamic Range 110dB
Analog Noise Floor -89 dBu (A-weighted)
Channel Isolation 108 dB (1 kHz)
Phantom Power +48V/10mA max
Output
Output Dynamic Range 112dB n/a n/a
Output Impedance 600Q
Expander v v v v v
Compressor v v v v v
Parametric EQ 8 band 5,8 & 12 band 5,8 & 12 band 5,8 & 12 band 8 band
Graphic EQ - 10, 15 & 31 band 10, 15 & 31 band 10, 15 & 31 band -
Gate - v v v -
Ducker - v v v -
High and Low Pass Filter v v v v v
Delay v 4 v v v
Limiter v v v v v

Automatic Gain Control (AGC) v v v 4 -

Adaptive Feedback Control (AFC) v v v v -

Ambient Noise Compensation (ANC) - 4 v v -

Acoustic Echo Cancellation (AEC) 2 1 1 1 0

Automatic Noise Suppression (ANS) v v v 4 -

Mixing Matrix v v v v v

Voice Activated Camera Control - 4 v v -

Ethernet Port (RJ-45) 2 Dante Audio 2 Dante Audio 1 LAN 2 Dante Audio 1 LAN 2 Dante Audio 1 LAN 2 Dante Audio 1 LAN

USB Port (Type-A) 1 USB Audio 1 USB Audio 1 USB Audio 1 USB Audio 1 USB Audio

Serial Port (Terminal Block) 1RS-232 1RS-485 1 RS-232 1RS-485 1RS-232 1RS-485 1RS-232 1RS-485 1RS-232 1RS-485

GPI/O Port (Terminal Block) - 8x8 GPI/O 8x8 GPI/O 8x8 GPI/O 8x8 GPI/O

lpower ... |

Power DC12V/PoE48V 110-240 VAC 110-240 VAC 110-240 VAC 110-240 VAC
50-60 Hz 50-60 Hz 50-60 Hz 50-60 Hz

Power Consumption 10W 25W 35W 15W 1I5W

Chassis Half Rack 1U 1U 1U 1U
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Appendix H: Architect and Engineers Specification

DTX-44D

The audio DSP shall have 4 balanced inputs and 4 balanced output channels for microphone or line-level analog audio
signals, each independently controllable with removable euro block connectors. The DSP shall have Dante® digital audio
networking up to 4 input and 4 output channels on 2 RJ-45 jacks, USB audio and 2 serial ports on a removable euro
block. One of the RJ-45 jacks shall support PoE PD at 15W to power the DSP. An additional 12VDC input jack shall be
provided as a secondary power source.

The audio DSP shall be a 1/2 RU rack mountable chassis and include configurable signal processing, including but not
limited to: signal routing and mixing, equalization, filtering, dynamics, delay, as well as Automatic Gain Control (AGC),
Adaptive Feedback Control (AFC), Acoustic Echo Cancellation (AEC) and Automatic Noise Suppression (ANS) with no
additional licenses. The audio DSP shall be controlled, configured and monitored via Dash software, UDP or serial
control.

The audio DSP shall be compliant to UL60065 (8th edition), CAN/CSA-C22.2 No.60065 (8th edition), IEC/EN60065 (8th
edition), UL62368-1 (2nd edition), CAN/CSA C22.2 No. 62368-1-14 (2nd edition), and IEC/EN 62368-1 (2nd edition); EN
55032:2015, EN 61000-3-2:2014, EN 61000- 3-3:2013, EN 55035:2017, FCC Part 15B Class A, AS/NZS CISPR 32:2015,
ICES-003 Class A, and CISPR13.

Warranty shall be five years. The audio DSP shall be Aurora Multimedia DTX-44D.

DTX-88D

The audio DSP shall have 8 balanced inputs and 8 balanced output channels for microphone or line-level analog audio
signals, each independently controllable with removable euro block connectors. The DSP shall have Dante® digital audio
networking up to 8 input and 8 output channels on 2 RJ-45 jacks, an Ethernet connection for control and programming
on a separate RJ-45 jack, USB audio, and 8 channels of configurable GPIO and 2 serial ports on a removable euro block.

The audio DSP shall be a 1 RU rack mountable chassis and include configurable signal processing, including but not
limited to: signal routing and mixing, equalization, filtering, dynamics, delay, as well as Automatic Gain Control (AGC),
Ambient Noise Compensation (ANC), Adaptive Feedback Control (AFC), Acoustic Echo Cancellation (AEC), Automatic
Noise Suppression (ANS) and Automatic Voice Tracking Camera Control with no additional licenses. The audio DSP shall
be controlled, configured and monitored via Dash software, UDP or serial control.

The audio DSP shall be compliant to UL60065 (8th edition), CAN/CSA-C22.2 No.60065 (8th edition), IEC/EN60065 (8th
edition), UL62368-1 (2nd edition), CAN/CSA C22.2 No. 62368-1-14 (2nd edition), and IEC/EN 62368-1 (2nd edition); EN
55032:2015, EN 61000-3-2:2014, EN 61000- 3-3:2013, EN 55035:2017, FCC Part 15B Class A, AS/NZS CISPR 32:2015,
ICES-003 Class A, and CISPR13.

Warranty shall be five years. The audio DSP shall be Aurora Multimedia DTX-88D.
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DTX-1616D

The audio DSP shall have 16 balanced inputs and 16 balanced output channels for microphone or line-level analog audio
signals, each independently controllable with removable euro block connectors. The DSP shall have Dante® digital audio
networking up to 16 input and 16 output channels on 2 RJ-45 jacks, an Ethernet connection for control and
programming on a separate RJ-45 jack, USB audio, and 8 channels of configurable GPIO and 2 serial ports on a
removable euro block.

The audio DSP shall be a 1 RU rack mountable chassis and include configurable signal processing, including but not
limited to: signal routing and mixing, equalization, filtering, dynamics, delay, as well as Automatic Gain Control (AGC),
Ambient Noise Compensation (ANC), Adaptive Feedback Control (AFC), Acoustic Echo Cancellation (AEC), Automatic
Noise Suppression (ANS) and Automatic Voice Tracking Camera Control with no additional licenses. The audio DSP shall
be controlled, configured and monitored via Dash software, UDP or serial control.

The audio DSP shall be compliant to UL60065 (8th edition), CAN/CSA-C22.2 No.60065 (8th edition), IEC/EN60065 (8th
edition), UL62368-1 (2nd edition), CAN/CSA C22.2 No. 62368-1-14 (2nd edition), and IEC/EN 62368-1 (2nd edition); EN
55032:2015, EN 61000-3-2:2014, EN 61000- 3-3:2013, EN 55035:2017, FCC Part 15B Class A, AS/NZS CISPR 32:2015,
ICES-003 Class A, and CISPR13.

Warranty shall be five years. The audio DSP shall be Aurora Multimedia DTX-1616D.

DTX-3232D
The audio DSP shall have Dante® digital audio networking up to 32 input and 32 output channels on 2 RJ-45 jacks, an

Ethernet connection for control and programming on a separate RJ-45 jack, USB audio, and 8 channels of configurable
GPIO and 2 serial ports on a removable euro block.

The audio DSP shall be a 1 RU rack mountable chassis and include configurable signal processing, including but not
limited to: signal routing and mixing, equalization, filtering, dynamics, delay, as well as Automatic Gain Control (AGC),
Ambient Noise Compensation (ANC), Adaptive Feedback Control (AFC), Acoustic Echo Cancellation (AEC), Automatic
Noise Suppression (ANS) and Automatic Voice Tracking Camera Control with no additional licenses. The audio DSP shall
be controlled, configured and monitored via Dash software, UDP or serial control.

The audio DSP shall be compliant to UL60065 (8th edition), CAN/CSA-C22.2 No.60065 (8th edition), IEC/EN60065 (8th
edition), UL62368-1 (2nd edition), CAN/CSA C22.2 No. 62368-1-14 (2nd edition), and IEC/EN 62368-1 (2nd edition); EN
55032:2015, EN 61000-3-2:2014, EN 61000- 3-3:2013, EN 55035:2017, FCC Part 15B Class A, AS/NZS CISPR 32:2015,
ICES-003 Class A, and CISPR13.

Warranty shall be five years. The audio DSP shall be Aurora Multimedia DTX-3232D.
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DTX-6464D

The audio DSP shall have Dante® digital audio networking up to 64 input and 64 output channels on 2 RJ-45 jacks, an
Ethernet connection for control and programming on a separate RJ-45 jack, USB audio, and 8 channels of configurable
GPIO and 2 serial ports on a removable euro block.

The audio DSP shall be a 1 RU rack mountable chassis and include configurable signal processing, including but not
limited to: signal routing and mixing, equalization, filtering, dynamics, delay. The audio DSP shall be controlled,
configured and monitored via Dash software, UDP or serial control.

The audio DSP shall be compliant to UL60065 (8th edition), CAN/CSA-C22.2 No.60065 (8th edition), IEC/EN60065 (8th
edition), UL62368-1 (2nd edition), CAN/CSA C22.2 No. 62368-1-14 (2nd edition), and IEC/EN 62368-1 (2nd edition); EN
55032:2015, EN 61000-3-2:2014, EN 61000- 3-3:2013, EN 55035:2017, FCC Part 15B Class A, AS/NZS CISPR 32:2015,
ICES-003 Class A, and CISPR13.

Warranty shall be five years. The audio DSP shall be Aurora Multimedia DTX-6464D.
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Aurora Multimedia Corporation

Distributed by U.T.E. electronic

Phone: +49 (0)2302 28 28 3-0 | Mail: info@ute.de
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